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PREFACE 

This style manual is intended to assist California Energy Commission staff, contract 
managers, and consultants/contractors when preparing a “consultant report “ to submit 
under an Energy Commission contract. 

If you have been awarded a contract to prepare a report for the Energy Commission, be 
sure to check these guidelines before starting any Energy Commission report. 

If your contract is for technical research that results in an interim or final report for the 
Public Interest Energy Research (PIER) Program, do not use this Style Manual. Instead, 
please use the Energy Commission report: Preparing Public Interest Energy Research 
(PIER) Program Contract Research Reports - Style Manual, Energy Commission publication 
number  CEC-500-2006-006. 

The most recent version of this manual and templates for use with Microsoft® Word® 
that can be used to develop Energy Commission contractor/consultant reports are 
located at: 

www.energy.ca.gov/contracts/consultant_reports/  

 

The project’s Contract Terms and Conditions may provide additional information about 
producing Energy Commission consultant reports or other printed materials. 

If you are not sure these guidelines apply to your report, or if you have any questions 
about the information provided in the guidelines, please contact your Energy 
Commission contract manager or e-mail Media and Public Communications Office staff 
at: mediaoffice@energy.state.ca.us  

 

 

 

 

 

 

 

 

 

Please use the following citation for this report: 

Aldrich, Bob, Susanne Garfield-Jones, Lana McAllister, and Carol Robinson. Style 
Manual for Preparing Consultant Reports for the California Energy Commission. 
California Energy Commission, Media and Public Communications Office. 
Publication number CEC-180-2008-002. 
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ABSTRACT 

This report is the manual of style to be used by consultants, contractors, or project teams 
that write reports funded by the California Energy Commission. This document will be 
placed online under the contracts section of the main Energy Commission website. 
Microsoft® Word® files for the document templates, covers, and credits pages can be 
downloaded from those pages as well. 

This document may be revised as the Energy Commission feels is necessary. Please 
check the contracts/funding page on the Energy Commission's website for the latest 
version at:  

www.energy.ca.gov/contracts/consultant_report/ 

 

 

Keywords: California Energy Commission, writing, style manual, style guidelines, 
consultant report, contractor report, publication process, report preparation, report 
format 
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CHAPTER 1:  

What This Report Is About 

Introduction 

The Energy Commission produces several hundred reports as well as other printed 
items each year. These documents are made available to the public and are placed on the 
Commission’s website. The Commission contracts with various entities to write reports 
on specific topics. This manual is geared toward assisting contractors or consultants1 in 
preparing these reports.  

Please note that many Energy Commission contracts require that periodic progress or 
status updates be written. This manual does not cover those progress or status reports, 
including the final status report of a contract. 

The Energy Commission believes that all its printed materials should properly reflect 
our image and identity such as name, seal, logos, and other relevant information. This 
principle is not to suggest that all printed documents be identical in appearance; 
however, all documents need to have a consistent design, be grammatically consistent, 
clear and concise, and have an instant identity with other materials the Commission has 
prepared. 

As an author, you have the opportunity to demonstrate skill, creativity, and pride in 
your work as well as an obligation to meet the expectations of your audience and the 
Energy Commission. Readers should be able to rely on consistent, professional quality - 
regardless of the subject matter. 

We understand that you need to know what is expected to produce a quality report. 
This Style Manual clarifies the approved style at the Commission, including information 
on the approval process and formatting your document. One chapter is devoted to 
writing, including strategies for organizing a document, editing sentences, grammar, 
punctuation, mechanics, and proofreading. 

This Style Manual is available to all consultants preparing a report for the Energy 
Commission, and it is part of their contractual obligation to follow the Commission’s 
report format. 

When Commission staff members receive a report from a consultant, they should peruse 
the document to make sure it is free of grammatical errors, formatted to the Energy 
Commission's style, and is clear to the lay reader. If the report fails any of these criteria, 
it should be returned to the writer to revise to the Commission’s standards.  

Rather than develop a grammar book, we recommend that consultants purchase and use 
The Gregg Reference Manual, Tenth Edition. The Media and Public Communications Office 
also uses the Associated Press Stylebook and Libel Manual and recommends The Dictionary 
of Concise Writing to reduce clutter in prose.  

                                                        
1 The terms “contractor” or “consultant” are used interchangeably. To reduce confusion, the 
company contracted by the Energy Commission to produce a report will, hereafter, be referred to 
as “the consultant.” The report they are writing for the Commission is called the “consultant 
report.” 
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When these manuals do not clarify an issue in grammar, mechanics, and usage, the 
office relies on The Elements of Style by William Strunk Jr. and E.B. White and the Little, 
Brown Handbook, 10th edition, by H. Ramsey Fowler and Jane E. Aaron. 

If you have additional questions, do not hesitate to call the Media and Public 
Communications Office at 916-654-4989.  

 

Why Should You Use This Style Manual? 

The Energy Commission uses much of what’s contained in this Style Manual for its own 
staff, Committee, and Commission-adopted documents. By using this Style Manual, you 
will ensure that Energy Commission consultant reports have a consistent appearance 
and will be acceptable under the terms and agreements for contracts. It is the Energy 
Commission contract manager’s responsibility to ensure that any report done under 
contract follows this manual before final retention funds are released. 

Using this manual will help you meet the needs of your audience and achieve your 
purpose because the Style Manual is based on the latest efforts of the Media and Public 
Communications Office.  

Above all, using this Style Manual will free you from making decisions about 
formatting so that you can concentrate on the more creative elements of writing, the 
content of a document, the important work that you do best.  

Above all, using this Style Manual will free you from making decisions about 
formatting and writing style so that you can concentrate on the more creative elements 
of writing, the content of a document—the important work that you do best.  

There are legal grounds for “good writing.” California Government Code Section 6219 
says: 

6219. (a) Each department, commission, office, or other administrative agency of state 
government shall write each document that it produces in plain, straightforward 
language, avoiding technical terms as much as possible, and using a coherent and 
easily readable style. (b) As used in this section, a "state agency document" means 
any contract, form, license, announcement, regulation, manual, memorandum, or 
any other written communication that is necessary to carry out the agency's 
responsibilities under the law. 

 

Additionally, public funds pay for the reports. So, the public deserves the best document 
for its money. It deserves reports, papers, or presentations that are clear and well 
written. 

 

Updates to the Style Manual  

This Style Manual is a working document. The Media and Public Communications 
Office staff has tried to make it current; however, language, styles, and technologies 
change. This manual will be regularly reviewed, and any necessary changes will be 
incorporated into future editions.  
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The Media and Public Communications Office encourages your creative comments and 
constructive suggestions on improving the clarity of this manual and making it easier 
for you to use.  Please contact our chief editor at: 

Media and Public Communications Office 
1516 Ninth Street, MS-29 
Sacramento, California 95814 
Phone: 916-654-4989 
E-mail: mediaoffice@energy.state.ca.us 
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CHAPTER 2: 

Roles and Responsibilities for  

Preparing Consultant Reports 

Roles and responsibilities for consultant reports should be clearly defined in the contract 
between the California Energy Commission and the consultant. In general, the roles 
include: 

Role Responsibility 

Contractor / Consultant Performs the work stipulated in a contract with the 

California Energy Commission. 

They are also the author(s) of the consultant 
report sent to the Commission, usually at the 

conclusion of the contract. 

Consultant Contract Manager Is the main point of contact for the contractor or 

consultant with the Energy Commission 

Commission Contracts Office The office that oversees all contracts done by the 

Energy Commission with an outside firm or 

agency. 

Commission Contract Manager The contract manager is the authorized 
representative of the Energy Commission 

responsible for administering the contract, 

establishing and maintaining a good working 
relationship with the contractor, and monitoring 

and managing to all contract terms. 

Commission Project Manager Occasionally, a consultant’s project may contain 

multiple contracts. In that case, there is usually an 

Energy Commission project manager who 

oversees the entire project. 

Media and Public 

Communications Office 

Has overall responsibility for review, editing, and 

sign-off of all Energy Commission reports. 

M&PCO also manage the Commission’s websites 

and handles publishing of consultant reports to the 

Internet. 

 

Contract Manager’s Responsibilities 

The contract manager is the authorized representative of the Energy Commission 
responsible for administering the contract, establishing and maintaining a good working 
relationship with the consultant/contractor, and monitoring and managing all contract 
terms. 

The following summarizes the Energy Commission contract manager’s responsibilities:  
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1. Monitoring the contract progress and performance to ensure that the contractor 
is performing the services according to the quality, quantity, objectives, and time 
frames specified in the contract.  

2. Keeping in frequent contact with the contractor by phone or e-mail, and 
intermittently conducting on-site visits.  

3. Revising the schedule of deliverable due dates as long as the new dates are 
within the term of the contract.  

4. Preparing a CEC-84, Contract Progress Evaluation Form. This form documents 
the progress of the project, noting any problems or delays. It is submitted to the 
Energy Commission’s Contracts Office monthly or quarterly depending on the 
contract terms but is always required when approving an invoice.  

Note: PIER contract managers do not complete a CEC-8. Instead the Progress 
Report (completed by the contractor) addresses the project status.  

5. Keeping the Commission’s Contract Officer informed regarding any potential 
problems or difficulties or changes in the contract.  

6. Reviewing and approving the contractor’s invoices to:  

a. Substantiate expenditures for work performed, including travel and per 
diem, and the rates billed do not exceed the rates in the contract budget.  

b. Ensure there are sufficient funds to pay for all services rendered and 
required in the contract.  

c. Identify spending levels and consider partial reduction of contract funds 
and reassignment of funds (within the limitations of the Contract 
Manager).  

d. Ensure retention is withheld from the invoice, according to the retention 
language specified in the contract.  

7. Closing out the contract by:  

a. Ensuring that all work is completed and accepted before the contract 
expires.  

b. Approving the final products, including the final report and meeting, if 
required.  

c. Verifying that the contractor has fulfilled all requirements of the contract 
before approving the final invoice and releasing retention.  

d. Completing the Contractor Evaluation Form - STD 4, for consultant 
services contracts of $5,000 or more and submitting one copy with the 
Final Report (if required) to the Contracts Office.  

8. Verifying that one of the final deliverables, a consultant report, if applicable, 
meets all Energy Commission style and formatting contained in this Style 
Manual. 

9. Overseeing the review and sign-off process (via a CEC Form 5) before 
publication of the consultant report on the Commission’s website. 
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CHAPTER 3:  

Publication Steps for Consultant Reports 

 

Publishing a report with the Energy Commission should not be an all-consuming 
process.  It essentially breaks down into three areas (see Table 1 on next page): 

1) Steps 1 through 10 are generally pre-submission steps done by the contractor and 
contract manager.  

2) The general steps for document review and are reflected in Steps 11 through 23.  

3) Publishing a report involves Steps 24 through 29.  

 

This Style Manual should be reviewed at the beginning of the project report writing 
process, and format and styles must be followed. 

 

California Energy Commission staff should use the latest version of the Publication 
Approval Form (CEC Form 5) available on the Commission’s EnergyNet Intranet. 
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Table 1: California Energy Commission 

Report Creation, Review, and Publication Steps 

1 Pre-planning and conceptualizing the consultant report.  

2 Outlining and planning chapters and sections.  

3 Draft of report written by contractor / project team.  

4 Draft of report edited. Cover and credits page added. Table of Contents created. Report 

formatted using Energy Commission style template. 

5 Draft of report sent to Energy Commission contract manager for first review.  

6 Contract manager adds comments and suggestions and returns report to contractor.  

7 Comments and edits included into report. (This may be repeated a number of times.) 

8 Draft final of report submitted in Microsoft® Word® file to contract manager.  

9 Contract manager does final edit, checking to make sure comments are included.  

C
O

N
T

R
A

C
T

O
R

 &
 C

O
N

T
R

A
C

T
 

 M
A

N
A

G
E

R
 S

T
E

P
S

 

10 “Final” version of report submitted to Commission in Word® with all corrections made. 

Graphics and other supporting files submitted with report on CD-ROM or (if smaller than 10 
MB) via e-mail. 

11 Contract manager prepares CEC Form 5 to accompany report on sign-off route.  

12 Report sent to office manager for review and sign-off.  

13 Report sent to division chief for review and sign-off.  

14 Report sent to Media and Public Communications Office (M&PCO) for review, editing, and 
sign-off. M&PCO assigns publication number.  

 

Note: On consultant reports, M&PCO only edits the abstract and executive summary. The rest 

of the report is normally not edited, but is reviewed, by M&PCO. 

15 Reviewed report sent to policy committee presiding member for review and sign-off.  

16 Reviewed report sent to Executive Office for review and sign-off.  

17 Report returned to Commission contract manager. 

18 Edits incorporated into report by contract manager or by consultant/contractors (depending on 

what contract stipulates). Final retention funds released to contractor after edits completed and 
all files are sent to Commission. 

Note: M&PCO may request that the report be sent back to that office for a final review once 
edits are incorporated. 

19 Report given last, final review by contract manager.  
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20 Contract manager creates Adobe® Acrobat® Portable Document Format (PDF) file, fills in 
document properties on both Word and PDF files, and creates ADA accessibility in PDF. 

21 Contract manager sends Word®, PDF, graphics, and other files to Webmaster for posting on 

Energy Commission website and for archiving. 

22 Web Team: 

a. Checks Americans with Disabilities Act accessibility of PDF document. 

b. Checks PDF document properties. 

c. Adds report information to publications database.  

d. Puts report and graphic image of cover online. 

23 Webmaster sends PDF of final publication to Commission Library and Publications Unit. 

(These are usually sent at the beginning of each month on a CD-ROM.) 

24 Publications Unit prints master paper copy and prints limited number of inventory copies. 
Contract manager should contact publications if additional printed copies are desired. 

25 Publications Unit sends printed copies to state depository libraries. E
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26 Webmaster archives electronic version(s) of publication to be kept indefinitely.  
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CHAPTER 4:  

Preparing Accurate, Consistent Reports  

Before you begin writing, put on the hat of an inquisitive, reasonably well-educated lay 
reader. Pretend that he or she paid for this report and wants to understand how and 
why you spent the money. That’s your audience. Even though colleagues in the energy 
industry may be the only people who read your report, you need to make the writing 
clear and understandable to a larger audience. Your reader may not speak or read 
English as a first language. So, you must write clearly and concisely.  

Here are some suggestions to keep in mind as you write the report:  

• Apply the test of completeness. Are all the pieces there? Are all the references 
clear and do those in the text match those in the reference section? Are the 
relationships between the partners and the players clearly explained?  

• Apply the test of logic. Does the document flow and make sense? Is the need for 
the research clearly described? Is the technical approach clearly described? Do 
the conclusions make sense? Are they drawn from the analysis? Do the numbers 
check? Is it clear how the numbers were derived?  

• Analyze data that you present in the report. If you present a picture, graph, or 
table, be sure that you discuss it in the text; do not just refer to it. Remember, not 
everyone wants to or can print in color, so it is best if your graphic can also be 
copied in black and white. Apply the “would this be clear if it were faxed” test.  

• Make sure you substantiate each conclusion by the analysis contained in the 
report.  

• Figures and tables must clearly relate to and be consistent with the text, and vice 
versa. (If the text says the generator had a capacity of 30 megawatts, the table 
should not say it was 31.2 megawatts.)  

• Use consistent references to report performance specifications and results. For 
example, if you refer to a piece of equipment by its nominal nameplate rating, 
then use that reference consistently throughout the report. If, however, the 
desired number was the measured performance of the device (almost always 
different from nameplate), then consistently use that measured number. Do not 
mix the two in the narrative.  

• The text needs to clearly refer to the attached appendices (if applicable). It should 
also explain how the material in the appendices relates to the text. If the content 
does not really matter, you should probably drop the appendix. References to 
multi-page appendices need to be specific to the page or section of the appendix, 
not just a general reference to “Appendix B.” Number appendices’ pages 
consistently.  

 

If you have a question about what the report should include, contact your contract 
manager first. The Media and Public Communications Office is also available to discuss 
the report. Make sure you understand all the required parts.  
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CHAPTER 5:  

Content Style for Reports  

Apply general rules for good writing to all reports and other written materials created or 
funded by the Energy Commission. The following books are recommended to assist 
authors in developing good writing habits:  

Fiske, Robert Hartwell. The Dictionary of Concise Writing: 10,000 Alternatives to Wordy 
Phrases. Marion Street Press, 2002. ISBN: 0966517660.  

Sabin, William A. The Gregg Reference Manual (10th edition). McGraw-Hill Irwin, 2005. 
ISBN: 0072936533.  

Strunk Jr., William, E. B. White, and Roger Angell, The Elements of Style, Fourth 
Edition. Longman, 2000. ISBN: 020530902X.  

Style Manual Committee, Council of Science Editors. Scientific Style and Format: The 
CSE Manual for Authors, Editors, and Publishers (7th Edition). University of 
Cambridge, 2006. ISBN: 097796650X.  

University of Chicago Press Staff (Editor). The Chicago Manual of Style (15th Edition). 
University of Chicago Press, 2003. ISBN: 0226104036.  

 

The above books may disagree on some grammar and punctuation formatting, such as 
using a “serial” comma. The Energy Commission preference is the Gregg Reference 
Manual.  

 

Writing Style  

• Use the active voice whenever possible:  

ACTIVE VOICE: The petroleum industry is building new storage facilities. 

PASSIVE VOICE: New storage facilities are being built by the petroleum industry. 

• The Energy Commission discourages the use of the first person (I, we, us, our) when 
referring to the author(s) in its reports. This is not to say that you should write in the 
passive voice. It is possible to write in the third person and still write in the active voice. 
For example:  

o Instead of third person passive voice: “It was found by the research team, or it was 
found by the researcher that...” 

o Use third person active voice: “The research team or the researcher found that...” or 
“The study found that...” or “Results showed that...”  

• Writing in the third person requires that the authors refer to themselves as though they 
were referring to a third party:  

o First person: “We considered 12 different scenarios...” 

o Third person: “The authors (or “the research team” or “the researcher” or “this 
project” or some other similar third-party reference) considered 12 different 
scenarios..."  
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• Avoid using “there is,” “there are,” or “it is” because those phrases set up a passive voice 
sentence and obscure its meaning.  

• Eliminate excess words. For example, say “To calculate the emissions...” NOT “In order 
to calculate the emissions....” The Dictionary of Concise Writing can help writers use fewer 
words to convey their message. For example, say, “The team analyzed ...” and not “The 
team conducted an analysis of ...” 

• Avoid using “and so forth,” “e.g.,” or “i.e.” Instead, use “and so forth,” “for example,” or 
“that is,” respectively, or another appropriate substitute.  

 

Acronyms and Abbreviations 

An acronym is an abbreviation made up of the initial letters of a group of words and is 
pronounced as a single word. For example, HVAC (heating, ventilation, and air 
conditioning) is pronounced H-VAC. Abbreviations are the initial letters of a group of 
words but cannot be pronounced as a single word and in which each letter is spoken 
indivdually, such as CPUC and PG&E. The Energy Commission uses these two terms 
interchangeably, most often including abbreviations under the umbrella of acronyms. 

Use acronyms sparingly! They are a form of shorthand for terms used repeatedly that 
are familiar to your readers. Don’t make up your own acronyms. This style of writing 
excludes the reader by introducing words that are only known to a “select few.” 

An acronym should benefit the reader, not cause them to stop reading and start hunting 
for the first time the acronym was used. Acronyms may be disallowed at the discretion 
of the Energy Commission’s editors. 

Follow these rules when using acronyms or abbreviations. 

• Do not make up acronyms as shorthand for a group of words. 

• Do not use the abbreviation “CEC” in reports or in other written materials, 
except if used in a table heading where space is critical. Use “California Energy 
Commission” at first mention, and then use "Energy Commission" throughout 
the rest of the report. You may use just “Commission” in subsequent references 
in the same paragraph as long as no other commissions are being mentioned. 
Return to using the full two words Energy Commission in subsequent 
paragraphs. 

• Introduce acronyms by first using the full term, followed by the acronym in 
parentheses. Energy Commission style does not allow the use of acronyms in the 
abstract and executive summary because these sections may need to stand alone 
and because these elements are often read by a broader audience that may be less 
familiar with the subject matter. Very common acronyms or abbreviations are 
acceptable in abstracts and executive summaries. (See Table 1.) 

• Do not introduce and use an acronym if it only appears once or twice in close 
proximity. Rare exceptions would be cases where readers are more familiar with 
the acronym than its actual referent. 

• Do not use the U.S. Postal Service’s two-letter abbreviations for states in the 
United States. Instead, use the full state name (example: Sacramento, California). 
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Table 2: Common Acronyms and Abbreviations 

Original Term Acronym/Abbreviation 
California Energy Commission Energy Commission 

British thermal unit Btu 

California Air Resources Board ARB (not CARB) 

California Department of Water Resources DWR 

California Environmental Protection Agency CalEPA 

California Independent System Operator California ISO (not CAISO or Cal-ISO) 

(California) Public Utilities Commission CPUC 

carbon dioxide CO2 or CO2 (Note: Make sure the 2 it is not too small to read.) 

cubic feet per minute CFM 

(United States) Department of Energy U.S. DOE 

Energy Action Plan Energy Action Plan (not EAP) 

Energy Efficiency Ratio, Seasonal Energy Efficiency Ratio EER, SEER 

ENERGY STAR® ENERGY STAR® on first reference, followed by ENERGY 
STAR thereafter. Note: Should be all capitals. 

Federal Energy Regulatory Commission FERC 

gigawatt / gigawatt-hour GW / GWh 

heating, ventilation, and air conditioning HVAC 

Integrated Energy Policy Report IEPR 

kilovolt kV 

kilowatt / kilowatt-hours kW (small k, capital W) / kWh 

liquefied natural gas, liquefied petroleum gas LNG, LPG 

Los Angeles Department of Water and Power LADWP 

MCF MCF but in parentheses say (1000 cubic feet of natural gas) 

megawatt / megawatt-hour MW (all capitals) / MWh 

nitrogen oxides NOx or NOx 

Nuclear Regulatory Commission NRC 

Organization of Petroleum Exporting Countries OPEC 

Pacific Gas and Electric Company PG&E 

photovoltaic PV 

Public Interest Energy Research Program PIER Program 

one quadrillion (10
15

) British thermal units Quad 

research, development, and demonstration RD&D 

Sacramento Municipal Utility District SMUD 

San Diego Gas & Electric Company  

Note: An ampersand is the correct usage in the company’s name.  
SDG&E 

Southern California Edison Company SCE 

Southern California Gas Company SoCal Gas 

sulfur oxides SOx 

United States United States (not U.S. unless it proceeds an abbreviation for 
a federal agency) 

United States Environmental Protection Agency U.S. EPA (not EPA) 
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Bulleted Lists  

Consider using a bulleted list for complicated sentences like the following example:  

This report provides policy recommendations to conserve resources; protect 
the environment, the economy, and public health and safety; and ensure 
reliable, secure, and diverse energy supplies.  

The above is correct, but it is clearer if bullets are used.  

 This report provides policy recommendations to:  

• Conserve resources. 

• Protect the environment, the economy, and public health and safety. 

• Ensure reliable, secure, and diverse energy supplies. 
 

Note: Gregg Reference Manual (p. 106) states that you should “...use 
periods after short phrases that are essential to the grammatical 
completeness of the list.” In the above example, you should not use 
semicolons at the end of the first and second bullet. Nor would you put 
the contraction “and” at the end of the second bullet. The above bulleted 
items are incomplete sentences on their own, but because they 
grammatically complete the lead-in phrase, periods are used. 

 

In bulleted lists, use “parallel construction” for the items in your list. For example, if one 
item starts with a verb, all items should start with a verb; if one item begins with a noun, 
all items should begin with a noun, and so forth.  

Use the following guides for punctuating bulleted lists:  

• Start each bulleted element with a capital letter. 

• Place a period at the end of each listed element that is a complete sentence. 

• Incomplete sentences should not have a period unless they are “essential to the 
grammatical completeness of the list.” (See note above.) 

• Semicolons or commas should not be used. 

• The word “and” should not end the second to the last bulleted item. 

 Do not use small graphic files in place of the standard bullets.  

 

Format for Bulleted Lists 

1) The hierarchy for bullets should be: 

• Bullet item (round, solid disc) 

o Second level bullet (open circle) 

 Third level bullet (solid square) 
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- Fourth level bullet (hyphen) 

 

2) Add an additional return (extra line) at the end of the bullets and before the next 
paragraph. 

3) Bullets use standard /normal text (Palatino, 11 pt.) but should only have a 4-point 
spacing following the paragraph. It is included in the blank document template, but you 
may have to change this manually. To do that, highlight the bulleted section, go to pull-
down menu:  

Format>Paragraph>Indents and Line Spacing>Spacing After = 4 points 

4) Always format bullets with a hanging indent, indenting 0.25-inch from the line above 
with the hanging indent at 0.50-inch from the line above. 

 

Capitalization  

Do not capitalize words to make them stand out in a text. For example, “The 
Department offered its services” is incorrect and should be “The department offered its 
services.” 

Just because acronyms and abbreviations are most often capitalized does not mean that 
you must capitalize the terms when they are written out. For example, you would not 
capitalize heating, ventilation, and air-conditioning (HVAC) system before listing the 
acronym in parentheses. 

Do not capitalize words in the following situtations:  

• Do not capitalize “state” unless the text specifically says “the State of California.” 

• Use “energy crisis”, NOT “Energy Crisis.” A proper noun, however, like “2001 
Energy Crisis” would be capitalized. 

• Use the lower case for “project” or “program” or “model” unless the term is an 
official part of a name or title, such as “Sunrise Transmission Project” or the 
“PIER Program” or the “Cost of Generation Model.” (In subsequent references to 
the project or program or model, use the lower case for the term even though it’s 
capitalized when you use the official name. For example, regarding the Sunrise 
Transmission Project, subsequent mentions would be to “the project” if you don’t 
want to use its full name.)   

• Use “website” (all one word, lowercase) and not “Website” or “web site.” 
However, use “Web page,” “Webmaster,” and “the Web.” Per the Gregg Reference 
Manual, to maintain a consistent style, it is better to retain the capital “W” until a 
majority of these terms (such as “World Wide Web”) lose their initial cap as well. 
“Website, however,” has lost the initial cap in most technology publications and 
websites. 

• Do not capitalize “city” before the name of a municipality. For example, “city of 
Sacramento,” not “City of Sacramento.” The actual name of the city is 
Sacramento, California. For some cities, the word “city” is part of its formal 
name, such as the City of Industry, California. 
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• Do not capitalize any term that is not a proper name or title. 

• Do not capitalize “staff.” 

Words that should be capitalized are:  

• Governor, Legislature, Senate, and Assembly (when pertaining to California).  

• Northern California, Southern California, Central California.  

 

Please note that the terms that are capitalized may disagree with some grammar 
conventions. These are Energy Commission style for using these terms. 

 

Compound Adverbs  

Don't hyphenate compound adverbs: “publicly owned utilities,” “newly created.” 

 

Compound Adjectives  

Many compound adjectives are hyphenated when they come before a noun: “investor-
owned utilities.” They are not hyphenated when they come after the verb: “the utilities 
are investor owned.” 

 

Internet and E-mail Addresses 

You can configure Microsoft® Word® to automatically create hotlinks to Internet 
addresses (URLs, short for Uniform Resource Locator) and a mail-to link for e-mail 
address. Creating the hotlink changes the text to blue and underlines the text (in Word® 
default settings). When a user clicks on the link, the text color changes to purple. 
Changing the Word® file to Adobe® Acrobat® sometimes incorporates the hotlinks. 
Please make sure the addresses are correct and tested before submitting a report.  

Try to not split Internet addresses across two lines. If you need to, put the website 
address on a separate line, centered. Or if the URL is still too long, reduce the point size. 
For example: 

http://www.energy.ca.gov/2007publications/CEC-180-2008-001/CEC-180-2008-001.PDF 

http://www.energy.ca.gov/2007_energypolicy/notices/2007-08-16_workshop_notice.html 

 

Italics  

Italicize the name of all books and reports. For example, use 2005 Integrated Energy Policy 
Report and 2004 Energy Policy Report Update. Do not underline. If the information cited is 
from a magazine, put the article title in quotations and the magazine name in italics. 

Use italics, not quotation marks, to introduce new technical terms. Include such terms in 
a glossary, if appropriate. 
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Language of Report 

When writing the report, use American, not British, English. 

 

Legislation 
(Referencing Legislation in Energy Commission Documents) 

For consistency, the following format should be used when referencing all legislation in 
reports or other documents: 

Bill # (Author, Chapter #, Statutes of “year”) 

Example: Senate Bill 1 (Murray, Chapter 132, Statutes of 2006) 

After that first reference, reference the bill as an abbreviation (SB 1) unless it has a formal 
title. 

If a bill has a formal title, the first reference should include the formal title followed by 
the bill information.  For example: 

Petroleum Industry Information Reporting Act (Senate Bill 1444, Holmdahl, Chapter 
1055, Statutes of 1980) 

After that first reference, reference the bill as a shortened title (PIIRA or whatever the act 
is commonly called). 

If a bill has not been signed into law, the reference would be to the bill title (Senate Bill 1) 
with additional references as the abbreviation (SB 1). 

 

Numbers  

In a list in linear text, use numbering (in parentheses) to indicate the order in which 
tasks should be done, to suggest chronology or relative importance among the items, or 
to clearly separate the items. For example:  

When repairing the machine, the researchers: (1) gathered the parts, (2) 
assembled the subsystems, (3) connected the subsystems, and (4) conducted 
tests to establish baseline performance.  

When establishing the policy, the state considered (1) wind turbines, both old 
and new; (2) energy conservation programs that encourage consumers to 
reap the benefits of off-peak electricity; and (3) photovoltaic installations—
including emerging technologies that use thin-film materials—in regions 
with superior insulation. 

Otherwise, do not use numbering, as in the following example:  

There are three key drivers of natural gas prices: supply, demand, and 
storage capacity.  
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Here are other rules for numbers: 

• Use numerals for 10 and above; spell out all numbers one through nine, EXCEPT 
when indentifying:  

o Percentages (2 percent)  

o Dates (June 2, 2005)  

o Page numbers (page 6)  

o Chapter numbers (chapter 4) 

o Energy increments (1 megawatt, 9 kilowatts) 

o Sentences that include a list of identical items, some of which are fewer 
than 10 and some are more: “We ran 2 trials in April, 5 in May, and 14 in 
June.” 

o Table and Figure numbers (Table 4, Figure 6) 
 

• Always use commas in numbers that are five digits or larger: 12,400; 245,678.  

• Insert commas four-digit numbers when they are used in tables or columns and 
are optional in text, unless needed to make the number clear.  

• Never begin a sentence with a numeral, including a year. “The energy crisis 
began in 2000,” NOT “2000 marked the year the energy crisis began.” 

• Always use a zero before a fraction smaller than 1.0. Use 0.25, not .25. 

• Treat related numbers alike:  
 Last year we sold 21,557,000 items; this year, nearly 23,000,000.  

• Repeat the word million (billion, and so forth) with each figure to avoid 
misunderstanding: 
 $5 million to $10 million (NOT: $5 to 10 million). 

• Use the metric system (International System of Units, or SI) or English units-
whichever is most appropriate to the report. When referring to temperatures, 
however, use Fahrenheit along with Celsius following in parentheses—for 
example, 212ºF (100ºC). Note that there should not be a space between the 
temperature, the degree symbol, and the letter. For executive summaries, use 
both SI and English units of measurement, to support a greater understanding by 
a lay audience. Use of other standard English measures (e.g., acre-foot, two-by-
fours) is always appropriate.  

 

Page Breaks  

If a subheading is at the bottom of the page, but the text jumps to the next page, put a 
page break before the subheading. Font metrics may be slightly different depending on 
the computer operating system. Including a page break will ensure that headings are not 
left alone at the bottom of a page with no content.  
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Percentages 

Always spell out the word “percentage” instead of using the % symbol except when 
used in a chart or graph. For example: 

• The U.S. Labor Department reported that September’s unemployment rate fell 
0.2 percent. 

• The sales tax rate in California can vary from 7.0 to as much as 8.5 percent. Fifty 
years ago, the tax rate was 2.5 percent. It increased to 3.5 percent four decades 
ago. It has never gone down. 

• It is permissible to use the % symbol in graphs and charts. 

 

Punctuation  

Apostrophes and Quotes 

Use “smart” (also called curly or typographic) quotes ( “ and “ ) and apostrophes ( ‘ ). 
These quote marks and apostrophes have a slight angle to them to distinguish them 
from the inch- and foot-mark. 

 

Brackets 

Use brackets for parenthetical material within parentheses. (Within the parentheses, 
separate the text [parenthetical material] from the rest of the sentence.)  

 

Colon and Semicolon 

Use only one space (not two) after a colon or a semicolon. 

 

Commas  

Use a serial comma style throughout the report.  

Example: The research team tested the first, second, and third models.  

Note: The comma after “second” is called the serial comma and separates the 
terms in a simple series.  

In a serial list that has multiple units in each element of the list, use a semicolon instead 
of a comma to clarify groupings. 

Example: The breakfast menu items were coffee, tea, fruit juice, or milk; bacon and 
eggs; cold cereal and milk; hot oatmeal with cinnamon, apples, and cream; assorted 
sweet rolls; or fresh fruit and yogurt. 

Use commas to set off the main elements in an address or a title following a person's 
name.  

Example: The Energy Commission has been located at 1516 Ninth Street, 
Sacramento, California, for more than 20 years.  
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Example: Mary Jones, director of the project, is in charge of the contract. 

 

Commas in Dates  

Do not put a comma between a month and a year (July 2007), but do put a comma 
between a date and the year and after the year if in a sentence.  

Example: The Declaration of Independence was signed on July 4, 1776, in 
Philadelphia, Pennsylvania.  

Note: Use the standard American method of dating of month, date, and year.  

 

Hyphen (-), En Dash (–), Em Dash (—)  

When in doubt about whether to hyphenate a word, look it up in the dictionary or the 
Gregg Reference Manual. Words with the prefix “non”, “anti”, “pre”, “pro”, “multi”, “co” 
are not hyphenated, except when “non” is used with a proper noun, such as non-
English.  

Words with a prefix that ends in the same letter as the root word are hyphenated.  

 Example: She suffered from a pre-existing condition.  

Use for any set of words you want understood as one unit, but use them sparingly.  

 Example: It was an out-of-date idea.  

Use to join compound modifiers, unless one of the words is an adverb ending in “-ly.” 
Compound modifiers are two or more adjectives or adverbs that, if used separately, do 
not describe the word they modify: 

• The utility offers consumers many energy-saving ideas. 

• She was a newly elected senator. (“-ly” adverb, no hyphen)  

 

Use an en dash (–) between a range of numbers. From the Insert Menu, select Symbol > 
Special Characters > en dash. 

Use an em dash (—) instead of a double hyphen (- -). Do not add a space before or after 
the em dash. From the Insert Menu, select Symbol > Special Characters > em dash. 

 

Percentage Symbol 

Spell out the word “percent” if there is only a single reference to a percentage.  

Example: The state and local sales tax in the area was 7.75 percent. 

If there are multiple references within a sentence or paragraph, do not use the % symbol. 

It is permissible to use the % symbol in graphs and charts. 
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Period Spacing  

Use a single space after a period. Do not double space. If you’ve used double spaces, use 
the find and replace function in Word® to find double spaces and replace them with 
single spaces. 

 

Quotation Marks (“ ”)  

Use around titles of chapters, sections, article titles, or a coined word or phrase.  

• We read the chapter “Progress in Energy Programs,” from the Energy Efficiency 
Report: 1998.  

• The staff reviewed the “widget” design.  

 

Special Characters and Symbols 

Microsoft® Word® has a listing of special characters that you can use when typing. To 
view the special characters, go to Insert > Symbol. These special characters make use of 
the “Symbol” typeface that comes with and is installed by Microsoft® Word®. These 
special characters are the same across computer platforms. For symbols that are not in 
the standard typeface or font family, please contact Media and Public Communications 
Office to discuss using them in a report.  

 

Underlining 

Do not use underlines. Use bold or italics. 

Do not use underlines to differentiate a header or section. Use the style setting for that 
heading. 
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CHAPTER 6:  

Word Usage and Misusage 

The following words are those most misused in Energy Commission documents. For 
more information on usage, check The Gregg Reference Manual or The Dictionary of Concise 
Writing.  

additionally - also; and; as well; besides; beyond that (this) even; further; 
furthermore; moreover; more than that (this); still more; then; too; what is more.  

adopted, approved, passed, enacted - Amendments, ordinances, resolutions, and 
rules are adopted or approved. Bills are passed. Laws are enacted.  

adviser, advisor - The California Energy Commission uses a Public Adviser, not an 
advisor, but the Commissioners have advisors.  

affect, effect - “Affect” is a verb that means to change or influence. “Effect” is 
typically a noun that means the result.*  

 Correct:  The oil spill affected marine life for months afterward. 

 Incorrect:  The effect of the oil spill on marine life was devastating  

* Although affect can be a noun, we hardly ever use it at the Energy 
Commission. Effect can also be a verb, but we rarely use it.  

aid, aide - Aid is assistance. An aide is someone who serves as an assistant.  

assistance - aid, help, succor  

assure, ensure, insure - “Assure” means to promise. “Ensure” and “insure” are often 
used interchangeably, but use “ensure” for more general meanings for “to make 
certain.” Reserve “insure” for legal and financial matters.  

because of, due to - Use “because of” to match cause to effect. “Due to” is an adverb, 
which can be used when preceded by a linking verb. See examples.  

 Correct:  

Because of the plants’ lower efficiency, which makes them less 
competitive, some parties remain concerned that a significant portion of 
these plants would be retired in the near future.  

Some parties are concerned that a significant portion of these plants 
would be retired in the near future due to the lower efficiency of these 
plants that makes them less competitive. (Although correct, please note 
how this sentence is wordy and lacks emphasis.)  

 Incorrect: 

Due to their lower efficiency, some of these plants are less competitive, 
and some parties are concerned that a significant portion of these plants 
would be retired in the near future.  

before - Use “before”, not “prior to”.  
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brand names - Do not use brand names to describe a process unless that process is 
being used. The same is true for other common brand names, such as Scotch® tape, 
Kleenex® tissues, and Coke®. Always capitalize brand names.  

brief (concise, short, succinct) summary or synopsis - Just say “summary” or 
“synopsis”. Adding one of the adjectives listed would be redundant.  

call into question - challenge, contradict, dispute, doubt, question.  

capitol, capital - The word “capitol” refers to the buildings in, for example, 
Washington, D.C., and Sacramento. The word “capital” means the city where the 
seat of government is located. Do not capitalize it. Used in a financial sense, capital 
refers to money, equipment, or property. For example: 

• The state capitol is located near the Energy Commission. 

• The Energy Commission is located in the state capital. 

• They had the necessary capital to underwrite the project.  

 

concurrently - as one; at once; jointly; together.  

contractions - Do not use contractions in external Energy Commission reports, 
notices, and letters.  

contrary to - after all, apart (from).  

currently - now, today. (Note: If sentence uses present tense, you may not have to 
use the adverb.)  

data/datum - “Data” is plural. “Datum” is the singular form.  

effectuate - achieve, bring about, carry out, effect, execute, realize.  

e-mail - The word e-mail is not capitalized unless it begins a sentence. The word 
should be hyphenated as e-mail.  

entitled - Use “title”.  

eventuality - event, occurrence, outcome, delete.  

• Kodak should have prepared for this eventuality.  

• Kodak should have prepared for this outcome.  

 

expenditure - cost, expense. 

facility - bathroom, building, factory, hospital, jail, office, place, plant, prison, school.  

farther, further - The two words are commonly interchanged, but there is a 
distinction worth observing: farther serves best as a distance word, further as a time 
or quantity word. You can chase a ball farther than the other fellow; you pursue a 
subject further.  

FAX (all capitals) is the approved substitute for facsimile transmission.  
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federal: Capitalize “federal” only at the beginning of a sentence and for corporate or 
government entities that use the word as part of their formal names, such as Federal 
Express and Federal Trade Commission.  

first introduced - introduced.  

given the fact that - because, considering, for, given, in that, since, when.  

government - Capitalize “government” only at the beginning of a sentence and 
never abbreviate it.  

Governor - It should be capitalized at the beginning of a sentence, when used as a 
stand-in formal title (“The Governor signed the bill....”), or before the governor’s 
name (Governor Schwarzenegger signed the bill....”). Do not abbreviate in any 
usage.  

Homepage - Homepage is one word and is always expressed with a capital "H."  

however - The Associated Press Style Manual suggests that you not begin a sentence 
with the word however. Although the Media and Public Communications Office 
adheres to this principle in usage, it is one area where experts disagree. The Gregg 
Reference Manual, for example, notes this disagreement and concludes that the writer 
must determine where to place a transitional expression.  

imply, infer - “Imply” means to suggest; you imply something by your own words 
or actions. “Infer” means to assume, to deduct, or to arrive at a conclusion; you infer 
something from another person’s words or actions.  

impact - A strong word, impact denotes a forceful impingement, a collision, a violent 
communication of force. Often it is used when all that is intended is effect or 
influence, as in this example: “One of the questions raised by the Mayor’s attack on 
the Governor is its impact on their collaboration to give Sacramento an opportunity 
to vote on a new charter this year.” If the term environmental impact is quoted from 
a report, then it may be used in that context. Otherwise, environmental effect, 
environmental damage, or affect the environment are preferable.  

importantly - Avoid by rephrasing.  

Incorrect: More importantly, he paid for the damages. 

Correct: What’s more, he paid for the damages.  

Incorrect: With the breeze freshening, he altered course to pass inside the island. 
More importantly, as things turned out, he tucked in a reef. 

Correct: With the breeze freshening, he altered course to pass inside the island. 
More important, as things turned out, he tucked in a reef.  

in advance of - before. 

in agreement with - according to, by, following, in keeping with, in line with, in step 
with.  

in excess of - above, better than, beyond, faster than, greater than, larger than, more 
than, over, stronger than.  

in force and effect - active, at work, effective, in action, in effect, in force, in play, 
working.  
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in order that - for, so, so that, that.  

in order to - use to.  

in place of - for.  

in response to - after, because of, by, due to, following, for, from, in, out of, owing 
to, through, with.  

in short supply - meager, rare, scant, scarce, sparse.  

in sufficient number or quantity - enough.  

in terms of - about, as, for, as to, by concerning, for, in, of, on, regarding, respecting, 
through, under, with, delete.  

in the vicinity (of) - close by, close to, near, nearby.  

initially established - established.  

Internet - Internet is always expressed with a capital "I."  

irregardless - “Irregardless” is non-standard English. Use “regardless.”  

is compliant with - complies with. 

is subject to - depends on, hinges on.  

its, it’s - Do not confuse “its” with “it’s.“ “Its” is the possessive form of the third 
person, singular, neuter pronoun “it.” “It’s” is a contraction of “it is” or “it has.”  

jargon - Do not use jargon in Energy Commission documents. The audience of your 
document many not understand technical jargon, and street jargon may demean 
your audience or your document.  

locality - area, city, district, locale, place, point, region, site, spot, state, town, zone.  

memorandum of understanding - agreement. 

methodology - method. When developing estimates of market size, data 
extrapolation methodologies may be useful. When developing estimates of market 
size, data extrapolation methods may be useful. 

Note: When discussing a set of methods or procedures used, then 
“methodology” is appropriate. If it's only one method, use method.  

minimal - brief, least, lowest, minor, not much, scant, short, slight, smallest.  

minimize - decrease; lower; reduce. 

mitigate - moderate, soften, lessen, reduce.  

move forward - advance, continue, go on, happen, move on, occur, proceed, 
progress.  

occur - “Occur” refers to an accidental or unscheduled event. “Take place” refers to a 
planned event. An accident cannot "take place," nor can a business meeting “occur.”  

on a regular basis - bimonthly, biweekly, daily, hourly, monthly, regularly, weekly, 
yearly.  
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on-line - hyphenated except when talking about the specific Internet access 
company America Online.  

open to the public - public. "The Energy Commission business meeting is public."  

operational - active, live, running, working.  

over - “Over” means physically above. If you mean a greater amount or quantity, 
use “more than”.  

owing to the fact that - because, considering, for, given, in that, since.  

percentage point (unit) - Say “point”. Example: The U.S. Labor Department reported 
that the September unemployment rate fell 0.2 points, to 5.4 percent.  

policy maker - “Policy maker” is two words, not one. 

power plant - “Power plant” is two words, not one.  

preventative - preventive. 

principal, principle - “Principal” refers to someone who is first in rank or authority 
or describes something that is first in rank or authority.  

• He was the principal of the school. 

• It was the principal reason for the part's failure.  

“Principle” means truth, doctrine or rule of conduct, such as an uncompromising 
principle of honesty.  

prior to - Use “before”.  

raise questions about (on) - challenge, contradict, dispute, doubt, question.  

ratepayer - “Ratepayer” is expressed as one word. Bill payer and other similar 
words, however, are not.  

regardless of the fact that - although, but, even though, still, though, yet.  

remains to be seen - do not know, is not (now, yet) known, is uncertain, is unclear, is 
unknown, is unsure.  

split infinitive - There is a precedent since the 14th century for interposing an 
adverb between to and the infinitive it governs;  avoid the split infinitive unless the 
writer wishes to place unusual stress on the adverb.  

Incorrect: to diligently inquire. 

Correct: to inquire diligently  

staff - “Staff” is a singular noun and requires a singular verb. It is also called a 
collective noun, but it is used as a single unit.  

Wrong: Staff are involved in the project. 

Right: The staff is involved in the project.  

Right: The staff members give regular updates and participate in briefings.  

state - Do not capitalize when it stands in place of California.  
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statue and statutes - “Statue” is a likeness sculptured, modeled, or cast into a solid 
substance. “Statutes” pertain to decree in law.  

take into account - allow for, consider, provide for, reckon with, regard, weigh.  

that is - delete.  

Incorrect: This relates to the cost that is incurred by start-up firms.  

Correct: This relates to the cost incurred by start-up firms.  

there’s / there are - Do not use this contraction. In most instances, there will be a 
subject-verb disagreement, and it will be misused.  

Incorrect: There’s many ways to approach the problem. 

Correct: There are many ways to approach the problem, but there’s only one 
correct way. 

the state (or city or county) of - delete unless referring to the "State of California."  

under - “Under” means physically below or underneath. If you mean a lesser 
amount or quantity, use “less than.”  

unproven - unproved.  

utilize or utilization - use.  

we - Do not use first person (we, us, or they) or third persion (they, them, their) in 
reports, notices, or formal letters when referring to Energy Commission staff or the 
State of California. 

Webmaster - Webmaster is one word and is always expressed with a capital “W.”  

website - The term is one word, lower case.  

whether or not - if, whether  

who - “Who” and “that” may refer to persons. Use “who” when referring to 
individual persons. Use “that” when referring to groups, types, classes of persons.  

which - “Which” and “that” refer to places, objects, animals, things, and others. Use 
“which” for nonessential clauses. Set off “the which clauses” with commas. Use 
“that” for essential clauses. Do not use commas.  

Nonessential words, phrases, and clauses are not needed to complete the structure or 
meaning of a sentence. Nonessential elements supply supplemental, parenthetical, 
nice-to-know information. 

The report, which was completed and submitted on time, still requires 
substantial revision.  

Essential words, phrases, and clauses are needed to complete the sentence. They cannot 
be removed from the sentence because they provide need-to-know information.  

The report that the consultant submitted is complete, but the report that 
staff prepared will need additional work.  
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CHAPTER 7:  

Parts of Consultant Reports  

Report Sections 

Energy Commission consultant reports contain the following sections, in the following 
order: 

• Cover page (required). 

• Credits page (required) with Legal Disclaimer (required). The Energy 
Commission disclaimer is ALWAYS included. Disclaimers from other agencies 
or organizations are optional and should be placed on the otherwise blank page 
following the credits page (the back side of the credits page when printing 
double sided). 

• Acknowledgments page (acknowledgments are optional). 

• Citation (required). Normally, the citation appears at the bottom of the 
acknowledgments page. If there are no acknowledgments, the citation appears at 
the bottom of the preface or the “back side” of the credits page (see instructions 
later in this chapter). 

• Preface (optional). 

• Table of Contents (required, followed by List of Figures and List of Tables, if 
needed). 

• Abstract, including Keywords (required). 

• Executive Summary (required). 

• References (if applicable). 

• Glossary (if more than 10 acronyms or abbreviations are used, it is required). 

• Bibliography (if applicable). 

• Appendices (if applicable). 

• Attachments (if applicable).  

 

Except in very short reports (20 pages or less), each chapter must start on a new, right-
hand, odd-numbered page. Even in short reports, “front matter” sections and the 
executive summary should always start on a new page. If the preceding section ends on 
an odd-numbered page, insert a blank page to make the next section begin on the right-
hand, odd-numbered page. To view an example of a properly formatted contractor’s 
report, please visit our website at:  

http://www.energy.ca.gov/contracts/consultant_reports/ 
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Report Cover and Credits Pages 

Covers and credit pages for Energy Commission’s consultant reports use templates that 
are available from the Energy Commission's website at: 

www.energy.ca.gov/contracts/consultant_reports/ 

Complete the information on the credits page as fully as you can. You will be asked to 
provide the following information on those pages. Covers, credits page and blank pages 
on the reverse of those are not given page numbers. 

 

Figure 1: Consultant Report Cover 

 
 

Cover 

Elements used in Consultant Report covers are shown in Figure 1. Titles should be 
descriptive of the report.  They are in ALL CAPITAL LETTERS in Arial 18 pt. 

All Energy Commission external publications (reports, papers, presentations, brochures, 
flyers, fact sheets, CD-ROMs, and so forth) are assigned a publication number. The new 
format for publication numbers became effective January 1, 2005. It corresponds to 
American National Standard Z39.23-1997 for formatting and creating standard report 
numbers for technical reports. 

The format for publication number is  

CEC-XXX-YEAR-XXX 

The publication number parts are: the Commission’s ID, the division or 
office ID for which the report is written, the year the report is published, 
the sequential number of the report for that division. 

The Energy Commission will fill in the publication number when the report reaches the 
Media & Public Communications Office for editing and review. 
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Credits Page 

Figure 2: Consultant Report Credits Page 

 
The Credits Page requires the following parts: 

• Name of primary author(s) 

• Author's company, organization, or affiliation 

• Location of author's company, organization, or affiliation (city, state, and zip) 

• Contract/Agreement number (complete contract, grant, work authorization, 
and/or project number(s), as applicable) 

• Name of Energy Commission contract manager and project manager 

• Name of Energy Commission office manager 

• Name of Division Chief 

• Executive Director - Note: No Commissioners names are used on consultant 
reports. 

• Energy Commission disclaimer 
 

The following disclaimer on Consultant Report credits page is mandatory.   

DISCLAIMER 

This report was prepared as the result of work sponsored by the California 
Energy Commission. It does not necessarily represent the views of the Energy 
Commission, its employees or the State of California. The Energy Commission, 
the State of California, its employees, contractors and subcontractors make no 
warrant, express or implied, and assume no legal liability for the information in 
this report; nor does any party represent that the uses of this information will not 
infringe upon privately owned rights. This report has not been approved or 
disapproved by the California Energy Commission nor has the California Energy 
Commission passed upon the accuracy or adequacy of the information in this 

report. 
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The credits page should be only one page long. If more space is required, then please 
contact your Energy Commission contract manager.  

Additional Legal Disclaimers  

The California Energy Commission’s Legal Disclaimer is provided on the Consultant 
Report credits page template. If any other participating organization needs a legal notice 
on the document, please provide it on the separate page following the credits page.  

 

Publication Numbers 

All Energy Commission publications (reports, papers, presentations and speeches, 
brochures, flyers, fact sheets, CD-ROMs, DVDs, and so forth) are assigned a publication 
number. Presentations given at workshops and hearings are not assigned a publication 
number (at this time) unless a specific request is made.  

The format for publication numbers became effective December 4, 2004. It corresponds 
to American National Standard (ANS) Z39.23-1997 for formatting and creating standard 
report numbers for technical reports. 

The format for publication number is  

CEC - XXX - YEAR - XXX - suffix - format id 

The publication number’s parts are:  

• The Commission’s identification with the ANS. 

• The division, office, or program area number for which the report was 
originally written. 

• The year the report is published. 

• The sequential number of the report for that division. 

• A suffix (if needed). 

• A format identification (such as -BR for brochure, -CD, -DVD).  

 

Use a hyphen between each part. 

Staff members in the Media and Public Communications Office will assign the 
publication number when the document reaches them for editing and review. 

 

Suffixes at End of Publication Numbers 

Suffixes are added by the Media and Public Communications Office to the end of the 
publication number only if necessary to differentiate various versions, volumes, 
editions, or parts of the same document. The suffix is preceded by a single hyphen. 
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Other Report Sections 

Acknowledgments and Citation Page (Optional) 

This page comes before the preface and table of contents and is where page numbering 
begins with lowercase Roman numerals (i, ii, iii, iv, v, vi, and so forth.).  

Acknowledgments  

This section acknowledges or expresses appreciation to those who participated in the 
writing of the report. It may be a paragraph or a bulleted list of names and, if 
appropriate, their affiliations. Acknowledgments are optional. If acknowledgments are 
not included, do not create an acknowledgments page simply for the citation. Instead, 
put the citation at the bottom of the preface page. If there is no room at the bottom of the 
preface, then list the citation at the bottom of the blank page following the credits page 
(back side of credits when printing double sided).  

Citation  

It is mandatory to include a citation for your report in the following style: 

• Author last name, author first name (or initial). Note: If there are multiple 
authors, list with chief author’s name first, or list alphabetically. The first name in 
the series should have the last name followed by first name; all subsequent 
authors have the first name, then the last name. Use commas between authors’ 
names.  

• Year of publication. 

• Report title in italics. 

• California Energy Commission. 

• Energy Commission publication number.  

Typically, the citation is located at the bottom of the acknowledgments page. As stated, 
if there are no acknowledgments, the citation should go at the bottom of the preface 
page, or if there is no room there, place it at the bottom of the blank ("back side") page 
following the credits page.  

Citation Examples 

Please cite this report as follows: 

Wolman, H., R. E. Moon (Engineering International). 2007. Widgets and More. California 
Energy Commission. CEC-500-2006-987. (That is, Woolman and Moon work for 
Engineering International, so this optional method of listing authors incorporates 
both the authors and the company they work for.) 

Additional examples: 

Burt, Charles, Darren Cordova (Irrigation Training and Research Center, California 
Polytechnic State University). 2002. Electric Load Shifting in Irrigation Districts - 
California's Program. California Energy Commission. CEC-400-2002-002. 

Unnasch, Stefan, Michael Chan (TIAX, LLC). 2007. Full Fuel Cycle Assessment: Tank to 
Wheels Emissions and Energy Consumption. California Energy Commission. CEC-
600-2007-003.  
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Table of Contents 

Include the following sections in the table of contents:  

• Preface (optional) 

• Acknowledgement (optional) 

• Abstract and Keywords (required) 

• Executive Summary (required in all consultant reports) 

• Chapter number and title followed by subheadings using the following format: 
 
CHAPTER 1: Chapter Title in Title Case (Heading 1) 

o Subheading (Heading 2) 

 Sub-subheading  (Heading 3) 

 
• Appendices (if applicable) (Enter appendix letters and titles in the table of 

contents manually) 

• Attachments (if applicable) (Enter attachment numbers and titles in the table of 
contents manually) 

Generate the table of contents using Microsoft® Word®'s automated feature. To do so, 
go to Insert > Reference > Index and Tables > Table of Contents > OK. Add at least two 
levels of heads (no more than three) under the table of contents to help the reader know 
the contents of the chapters.  

For a preface and abstract, it may be necessary to enter a few periods before the page 
number so that the dot leader works properly. Note that appendix and attachment 
listings must be entered by hand. Do not provide page numbers for appendices or 
attachments. 

Following the table of contents, generate the list of figures and the list of tables, if 
needed, using Word®’s automated features. To do so, go to Insert > Reference > Index 
and Tables > Table of Figures. Under “Caption Label” choose either Figure or Table, 
then in Options, Style, choose "Figure caption" (for a figure) or “Table caption” (for a 
table) > OK. 

Update the table of contents, list of figures, and list of tables after all editing has been 
completed, and proofread to ensure that the entries are complete and correct. 
(Microsoft® Word®’s automatic table of contents feature, while very useful, is not 
perfect and can occasionally mis-create entries.)  

The table of contents should use a right-hand tab, set at 6.5-inches, and with a dot leader 
for the page numbers. Set other tabs (for subheading and sub-subheadings) at 0.25- and 
0.50-inch. Break long titles using a soft-return (shift-enter) and a hanging indent. 
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Figure 3: Example of Table of Contents 
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Abstract 

All Energy Commission reports are required to have a short abstract. This concise, 
informative summary of the report should be less than 300 words—about a half page, 
single spaced. (You can use “Word Count” in the “Tools” menu of Microsoft® Word® to 
check the number of words.) 

The abstract should address the report’s purpose, scope, methods, and major findings, 
including the report’s results, conclusions, and recommendations. Abstracting services 
publish abstracts to help readers determine whether a report is targeted to their area of 
interest; therefore, it should be understandable as a stand-alone document. The abstract 
should not contain undefined symbols, abbreviations, or acronyms, and should not refer 
to specific elements of the main report. It should not refer to other reports unless it is 
essential to clarify the document’s purpose. If the report is a supporting document to 
another report, that information should be noted. Do not, however, include citations in 
the abstract. 

The abstract must contain 5-20 keywords that will help search engines and other 
databases track the report's subject matter. Do not repeat words. The keywords should 
be listed separately five lines below the abstract. Separate each word by comma—
followed by a space—with no ending punctuation. For example: 

Keywords: solar, energy, photovoltaic, PV, cell, panel, building, integrated, 
BIPV, electricity production, distributed generation, CSI, emerging, 
renewables, program, rebate 

 

Executive Summary 

The executive summary is a final report in miniature, containing all the key information. 
It summarizes the report and should include the following headings: 

• Introduction or Background 

• Purpose (outlining the broad purpose) 

• Objectives (if appropriate) 

• Conclusions and/or Recommendations  

 

These sub-headings should appear in the table of contents.  

The executive summary is intended to be short (preferred length is 2-10 pages). It can 
use a succinct, bulleted format to summarize the pertinent points under each of these 
sections, or can be more conversational (but still succinct). Assume a non-technical, 
management-level readership.  

The introduction summarizes the purpose of the report and explains the reason the 
Energy Commission wrote the report. An introduction should give the relevant 
background and overview. It should define (at an intelligent layperson's level) the issue 
or problem being addressed by the report.  

As a report summary, the executive summary should not present new information that 
is not found in the main document, and the executive summary should not repeat the 
abstract.  
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Do not cite references in the executive summary, and with rare exceptions, do not use 
acronyms or abbreviations.  

The Executive Summary uses the same “Title Style” that is used on preface and abstract 
titles. 

The executive summary marks the division between front matter, using lowercase 
Roman numeral pagination, and the body of the report. Thus, the first page of the 
executive summary will always be page 1 (Arabic numbering) of the report. 

 

Chapters and Section Headings 

Chapters should be numbered (CHAPTER 1:, CHAPTER 2:, and so forth in upper case) 
followed by a colon, a space, and then the chapter title in title case.  

Use a soft return [shift-return] if you need to break the title into two lines. Try to not 
leave orphaned words  (words left alone). Instead use a soft-return to group words. 

You do not need to capitalize the following words, unless they begin the title:  

a an and by for or the 

 

Example: 

CHAPTER 1: How You Should Create Excellent Titles for the 

Energy Commission 

This example is awkward because it orphans the word “Commission.” Break the line 
(with shift>return) to group common words together: 

Good: 
  CHAPTER 1: How You Should Create Excellent Titles  

  for the Energy Commission 

Better: 
  CHAPTER 1: How You Should Create  

  Excellent Titles for the Energy Commission 

 

For sections within each chapter, DO NOT USE scientific or technical section 
numbering (Section 1.1, Section 2.1.6).  

 

References 

The references must list all documents cited in the body of the report. List references in a 
standard alphabetical format. Use Palatino Linotype font, 11 point (or one of the other 
approved body fonts). Please check that all of the references contained in the body of the 
report are accurate and that the full citation for each reference is listed in the references 
section. 

For formatting of references, consult the following books: 
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Sabin, William A. The Gregg Reference Manual (10th Edition). McGraw-Hill Irwin, 2005. 
ISBN: 0072936533. 

Style Manual Committee, Council of Science Editors. Scientific Style and Format: The CSE 
Manual for Authors, Editors, and Publishers (7th Edition). University of Cambridge, 
2006. ISBN: 097796650X. 

University of Chicago Press. The Chicago Manual of Style (15th Edition). University of 
Chicago Press, 2003. ISBN: 0226104036. 

 

List any documents referred to in the appendices in a reference section in that appendix; 
that is, each appendix carries its own references section. 

 

Glossary 

If the report uses more than 10 acronyms and abbreviations, please provide a glossary 
with definitions for each acronym. Use Microsoft® Word®'s table feature to create a 
two-column format with the acronym or abbreviation in the left column and the 
definition in the right column.  

 

Bibliography 

A bibliography includes references that were used in preparation of the report not cited 
in the report. This section is optional. If used, consult the same reference books 
mentioned in the references section, above, for formatting guidance.  

 

Appendices 

An appendix is supplementary material that is usually produced by the report’s 
author(s). Designate appendices by capital letters (Appendix A, Appendix B, Appendix 
C, and so forth), not numbers.  

The body of the report needs to refer clearly to the attached appendices. References to 
multi-page appendices need to indicate the specific page or section of the appendix, not 
just a general reference to “Appendix D.” The report should also explain how the 
material in the appendices matters to the text. If it does not really matter, the appendix 
probably should be dropped. 

If small enough, appendices will usually be a part of the actual report. There are two 
formats for the appendix cover page. An appendix cover page should appear similar to 
the following in Figure 9. The version on the left is the preferred because it saves paper 
as you would need an additional blank page so that the content starts on the right hand 
side. You can put the title of the appendix in all caps or in title case. 

Appendices page numbering should include the letter of the appendix followed a 
hyphen and then by the paper number. The cover page and the blank page behind it (if 
used) are not numbered.  

For example:  A-1, A-2, A-3; B-1, B-2, B-3; and so forth 
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Figure 4: Examples of Appendices’ Cover Pages  

When Included as Part of a Report 

 

Separate Appendices 

If a document’s file size (with appendices) is more than five or six megabytes, the 
appendix should be published as separate volume from the main report. All appendices 
must be either part of the main document or published as separate files. Appendices that 
are separate volumes are given their own cover and the same credits page as the main 
report. Appendix publication number is the same as the main report, but the suffix -AP 
is added to the end of the number  
( -APA, -APB, -APC, and so forth for multiple appendices that are published as separate 
volumes). See Chapter 8 for additional information. 

If the appendix has been previously published by another organization or agency with a 
different cover, it receives an Energy Commission cover page but no credits page. 

Further, if the appendix has been previously published by another organization or 
agency, you must provide written permission from the original publisher for the Energy 
Commission to post the material on the Energy Commission website indefinitely. See 
Chapter 8 for details. 

 

Attachments 

An attachment is supplementary but supporting material that may not directly relate to 
the report. For example, attachments can include a collection of news articles that 
appeared on a certain topic. To attach this material, you must provide written 
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permission from the original publisher allowing the Energy Commission to post the 
material on the Energy Commission website indefinitely. This written documentation 
should be given to the Webmaster and explained in the attachment. 

Attachments should use the Consultant Report Cover Template. 

Attachments are designated by roman numerals (for example., Attachment I, 
Attachment II). See Chapter 8 for more details. On the cover page where the words 
“Prepared By” are located, delete the words “prepared by” and include the following 
statement verbatim: 

 

This document is an attachment to a report published by the California 

Energy Commission. The Energy Commission did not fund this 

document, but the author(s) of the Commission report has(have) 

attached it as a supporting document. 

The California Energy Commission wishes to thank the copyright 

holder, [fill in name of author and/or publisher or whoever holds 
copyright], for permission to republish this document in electronic 

format on the Commission’s website.  

Please contact this document’s original author or publisher for 

additional information about the document.  
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Templates 

Once the report is written, you must format it useing the Commission-approved styles. 
Energy Commission staff must use the report typographic styles described in these 
guidelines. They are summarized in Chapter 9: Formatting Style Matrix for Reports. 
The style template—and boilerplate cover and credits page templates—are on the 
Energy Commission’s “EnergyNet” Intranet website at: 

http://energynet/Exec/doc_production/index.html 

 

To use the new Energy Commission Report Template, follow the steps in one of these 
methods: 

Method #1 - If Document Has Not Been Written 

 

1. Download the Blank Report Template file from the Documents Production Page 
on EnergyNet, the Commission's intranet website. 

2. Open the file. 

3. Use Save As… to save the file with a different file name as a regular Word® file 
(.doc) instead of a .dot file. 

4. Begin writing the document. Use the pull-down style menu to format various 
headings, sections, and parts as you go along. 

5. Save the file as you normally would. 

 

Method #2 - If Document Has Already Been Written 

 

1. Open the Word® file of a document that is already written. Note that you may 
have already inadvertently used styles that are generic to Word® or from 
another older document. You do not want these styles to be transferred to the 
new document as it may confuse the formatting of your report. 

2. Use Save As… to save the old document with a new file name as text-only 
(old_document.txt). This will strip out any previous formatting that may mess up 
the template.  

3. Close both the original document file and the new text-only file. 

4. Download the Blank Report Template file from the Documents Production Page 
on EnergyNet, the Commission's Intranet website. 

5. Open the file. 

6. Use Save As… to save that template file with a different file name as a regular 
Word® file (.doc) instead of a .dot file. 

7. Do one of the following: 
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a. Open the text-only file and copy and paste the entire text into the .doc file 
and then save. 

b. In the “Insert” pull-down menu, click File…  and insert the .txt file into 
the regular Word® file. 

8. Save the file as you normally would. 

 

Cover and Credits Page 

The cover and credits page is included as part of the blank report template Word® file 
with the proper blank pages and page numbering. If you are having problems with the 
cover and credits page interfering with the report layout, you can add those later after 
the body of the report is formatted and completed. 

In creating the title for the report, don’t leave orphaned words by themselves on a line. 
Use common sense as to where the breaks should be placed. 

 

Inserting a Cover/Credits Page File to a Report 

To insert the cover and credits page Word® file(s) to another Word file, do the 
following: 

Go to the point just before the place in the document where you want to insert the cover 
and credits pages. In the pull down menu go to: Insert>File…> then locate the file’s 
name you want inserted and insert it. 

You may need to adjust the page numbers in the footers. To do this, there needs to be a 
section break after the blank page following the credits page (fourth page front the front 
of the report). In the footer of the preface page, turn off the ‘Same As Previous’ in the 
footer control panel so the footer will not be the same as having no footer on the cover 
and credits page. Set the page numbering to Roman numeral i. 

 

Blank Pages 

Blank pages should be inserted after the cover page, the credits page, preface page, table 
of contents page, acknowledgements page, abstract page, and before each chapter so the 
new section or chapter will start on the right-hand side of the report when bound as a 
“book.” 

The one exception is when there is no acknowledgments page; in that case, if the citation 
will not fit on the preface page, the citation should be inserted at the bottom of the 
otherwise blank page that follows the credits page.  

Number all blank pages from the acknowledgments page onward (using Roman 
numerals). Do not number the cover or credits pages. 
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Figures, Graphs, and Tables 

Figures, graphs, and tables (graphics) should be clear and readable. The graphic should 
be introduced in the paragraph before and explained fully. Do not download and use 
lower resolution graphics from the Internet, such as in Figure 12. While these may 
appear to look fine on your computer monitor, when printed the picture will bit-map 
and look blurry. 

The title or label should be part of the report and not created as part of the graphic. The 
reason is that the graphic may have to be resized to fit the page. If the label is part of the 
graphic, the size of the label will change depending on the resizing of the graphic. 

The figure title should use the “Figure Title” style in Arial, 12 pt., bold, centered like 
this: 

 

Figure 5: Example of a Graphic Used In a Report 

 

SOLARA is the first apartment community in California to be fully powered by the sun 
and is the first project delivered under the California Energy Commission's New Solar 

Homes Partnership Program. 
Photo Credit: Community HousingWorks, developer/owner of SOLARA. 

Fonts contained within figures, graphs, and tables can be either serif or sans serif as long 
as that font presents the information clearly and is readable. Most, however, use a sans-
serif font like Arial or Helvetica for the information in figures, graphs, or tables. Chapter 
9 provides guidance for the typography of table cells and column heads.  

Captions or sources listed below a figure, graph, or table must use the style specified in 
the formatting matrix in Chapter 9. Captions and sources should also be separate from 
the figure or table and not embedded in the graphic file because of accessibility issues. 
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If used, the list of figures and list of tables should be automatically generated in a 
manner similar to the table of contents. If a figure or table title is particularly long, hand-
edit it in the list of figures/list of tables as you see fit. 

Original graphics files (for tables, charts, and so forth) must be submitted with your 
report. (See Chapter 11.)  If a chart or graph was created in Excel®, then that Excel® file 
should also be submitted with the report. 

 

Use of Colors in Graphs and Figures, Size of Fonts, and  

Other Graphic Elements 

Many times our reports are photocopied only in black and white. Therefore, it is 
important to use colors in charts, graphs, and figures that will reproduce well on a 
photocopy machine. Think and plan ahead for future readers because a chart may be 
photocopied from a photocopy. You want the information to be clear and easy to 
understand; the numbers should be large and clear enough to be read. 

Additionally, graphs, and figures may need to be reduced in size to fit on a page within 
the text. Make sure the font size in the graphic is large enough to be read if the graphic is 
shrunk in size.  

Graphics or figures should be created at a minimum of 300 dots per inch. 

 

Footnotes 

Use footnotes (not endnotes) in Energy Commission reports.2 Use them sparingly to 
briefly clarify terms or concepts that the average reader may not understand. Place 
footnotes at the bottom of the page on which they appear. Do not place footnotes at the 
end of a section.  

Insert footnotes using Word’s® footnote feature: Insert > Reference > Footnote. Footnote 
numbering should automatically readjust as footnotes are added or deleted.3 Enter 
footnotes after periods or commas. 

Do not use footnotes in report or chapter titles, and do not footnote headings or 
subheadings. 

 

Page Breaks 

If a subheading appears at the bottom of the page, but the text jumps to the next page, 
put a page break before the subheading. Font metrics may be slightly different 

                                                        
2 The footnote number appears in the text as a superscript; the footnote is at the bottom of the 
page.  

3 Microsoft® Word® will automatically superscript the footnote number at the bottom of the 
page. The Footnote Reference should be converted to Palatino 11pt., as shown in these examples. 
Use Footnote Text style for the footnote itself. Do not add an extra space between footnotes; the 
spacing is built into the style. 
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depending on the computer operating system. Including a page break will ensure that 
headings are not left alone at the bottom of a page with no content. 

 

Pagination 

Use Palatino Linotype 10 pt. for page numbers, centered at the bottom of each page. 

Pagination begins on the acknowledgments and citation page (as Roman numeral - i, ii, 
iii...) and continues in lowercase Roman numerals through the preface, table of contents, 
and the abstract. The cover and credits pages are not numbered. Number the blank 
pages but do not put "This Page Intentionally Left Blank" on blank pages. 

On the first page of the executive summary (or Chapter 1 if there is no executive 
summary), begin numbering “1” and continue sequential numbering throughout the 
document. See the Appendices and Attachments section for page numbering of those 
sections. 

 

Table of Contents 

Generate the table of contents should be generated automatically using Microsoft® 
Word®’s pull-down menu: Insert > Reference > Index and Tables feature. (Appendices 
or attachments must be added manually.) The table of contents is based on the style 
headings assigned to each section. Check the table of contents to make sure it has been 
updated correctly after each series of edits. Checking that chapters and headings agree 
with the page numbering should be the last task before creating the Adobe® Acrobat® 
PDF or printing the final master copy for reproduction. See Figure 8 for an example of a 
table of contents. 

 

Appendices and Attachments 

An appendix is usually supplementary material that is produced by the report’s 
author(s). An attachment is usually supplementary material that is produced by 
someone other than the author(s). See full discussion in Chapter 6. 

 

Copyright and Permissions 

If an attachment or an appendix has been previously published, the author must obtain 
written permission from the copyright holder before the Energy Commission can put 
that document on-line. 

You should ask for “written permission for electronic publishing of the document in 
Adobe® Acrobat® PDF format on the California Energy Commission’s website.” Make 
sure there is no time limit on the permission—that is, ensure that the file may be posted 
on the Energy Commission’s website indefinitely. 

Send a photocopy of the written permission to the Webmaster when you deliver the 
report and the appendix(ces) or attachment(s). 
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Most previously published documents will be posted as separate files, with their own 
cover pages. No credits page is needed for appendices or attachments not funded by the 
Energy Commission. On the cover page where the words “Prepared By” are located, 
please include the following statement: 

This document is an attachment to a report funded by the California Energy 
Commission. The Energy Commission did not fund this document, but the 

author(s) has/have attached it as a supporting document. 

The California Energy Commission wishes to thank the copyright holder, [fill 

in name of author and/or publisher or whoever holds copyright], for 
permission to republish this document in electronic format on the Energy 

Commission's website.  

Please contact the original author/publisher for additional information about 

the document.  

 

Appearance in Table of Contents 

When preparing the table of contents for the report, you may need to manually enter 
each appendix letter and title (or attachment number and title) into the table of contents.  

 

Preparing Appendices 

Appendices should use the same Energy Commission-required format and style as the 
main report. If an appendix was previously published using a different style and format, 
that organization’s or agency’s style and format does not necessarily need to be changed. 
Please contact Media and Public Communications Office for directions on this type of 
appendix.  

The content and format of an appendix is subject to editing just like the report itself. 

Appendices are typically included at the end of the main report. They are posted as 
separate documents if their inclusion in the final report creates a file that is larger than 
five megabytes. Multiple, short appendices may be combined into one volume. 

 

Appendices as Part of the Main Report 

If the appendices are short enough, they may be included in the same file as the main 
report. The first page of each appendix should be a title page, containing the following 
information:  

• The word “Appendix” (with letter A, B ,or C, and so forth if more than one 
appendix), in Arial 24 pt., bold, upper case. 

• Title of appendix, in Arial 18 pt., bold, upper or lower case. 

• A-1, A-2, A-3, and so forth (or B-1, C-1, and so forth), page numbering centered 
on the bottom of the page. Use Arabic numerals. 

See Figure 13 for a picture of what two appendix pages could look like.  



47 

Figure 6: Examples of Appendix as Part of Main Report 

 

Appendices as Documents Separate from the Main Report 

If an appendix is too large (more than 5.0 megabytes), it should be treated as a separate 
volume from the main report. Where the appendix would normally go in the main 
report, insert a ”slip sheet” that lists the following information: 

• Appendix A (or B or C, and so forth), in Arial, 24 pt., bold, then two returns. 

• Title of appendix, in Title Case, Arial, 22 pt., bold.  

• Text on the slip sheet saying: “This appendix is available as a separate volume, 
publication number CEC-XXX-YEAR-XXX-APX.”  

• The slip sheet has no visible page number. 

 

Please see Figure 13 (on the next page) for an example of a “slip sheet.” 

If there is more than one appendix, the titles of each appendix may be listed on a single 
slip sheet. The title of the page, in that case, should be “Appendices” (Arial 24 pt., bold) 
with the appendix letters and titles, and their publication number(s), neatly arranged as 
a list. Please see Figure 14 (on the next page) for an example of multiple appendices 
listed on a “slip sheet.” 

If you have multiple small appendices, they may be combined into a single volume if the 
file size permits. If the multiple appendices create a file larger than five megabytes, then 
separate volumes should be created for each appendix. Appendices are posted on-line in 
Adobe® Acrobat® PDF format. 
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Figure 7: Example of a “Slip Sheet” for Appendix A 

 

Each separate appendix must have its own cover page and publication number. If the 
Energy Commission funded the work, each separate appendix must also have a credits 
page. The Energy Commission provides the publication number when the report 
reaches the Media and Public Communications Office for review and sign-offs.  

 

Figure 8: Example of “Slip Sheet” for Multiple Appendices in One Volume 
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The publication number of an appendix consists of the main report’s publication 
number plus a suffix. If there is only one appendix, the suffix is -AP. If there are multiple 
appendices, the suffixes are -APA, -APB, -APC, and so forth, depending on the letter of 
the appendix. Therefore, the publication number for Appendix B of a fictitious report 
published in 2007 by the Energy Efficiency and Renewables Division would be: CEC-
400-2007-987-APB.  

If multiple appendices are combined in one volume, then the suffix is only -AP with no 
additional letter. 

If the work contained in the appendix was not funded by the Energy Commission, be 
sure the cover page contains the boilerplate copyright permission language provided 
earlier in the “Copyrights and Permissions” section. 

 

Attachments 

Attachments are supporting documents that were not written by the author of the main 
report. They are designated with Roman numerals rather than letters (Attachment I, 
Attachment II, and so forth). 

Attachments are usually published separately from the main report. Prepare a single 
“slip sheet” and cover page(s) the same way as for appendices. The Energy Commission 
will assign a publication number to each attachment. 

The publication number of an attachment consists of the main report’s publication 
number plus a suffix. If there is only one attachment, the suffix is -AT. If there are 
multiple appendices, the suffixes are -ATI, -ATII, and so forth, depending on the letter of 
the attachment. Therefore, the publication number for Attachment II of the same 
fictitious report published in 2007 by the Energy Efficiency and Renewables Division 
would be: CEC-400-2007-987-ATII.  

In most cases, attachments will require permission to publish from the copyright holder. 
It is the report author's responsibility to obtain this permission; be sure to include the 
boilerplate permission language on the cover page. A copy of the written permission 
should be given to the contract manager to send to the Energy Commission’s Webmaster 
to be filed in the Media and Public Communications Office’s copyright approvals filing 
cabinet. 
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CHAPTER 8: 

Formatting Style Matrix for  

Energy Commission Consultant Reports  

The following style types can be found in the report template document’s pull-down 
Style Menu located on the formatting bar in Microsoft® Word®. 

 

Style Type Definition Example 

Normal 

 

Use for all 
“regular” text that 
is not assigned a 
special style (e.g. 
heading,bullet, 
caption, and so 
forth) 

Palatino Linotype 
11 pt. 
Align left 
Spacing at single line,  
Space 0 pt before paragraph 
Space 8 pt after paragraph 

 

Palatino is used because of 
its readability due to its larger 

“x“ height and “m” width. 

If Palatino is not available, 
use Century School 11 pt. 
(second choice) or Times 
New Roman 12 pt. (last 

choice). 

Palatino Linotype  
(11 pt.) 
The quick, fast fox jumped over the 
lazy brown dog. 

Century Schoolbook  

(11 pt.) 
The quick, fast fox jumped over the 

lazy brown dog. 

Times New Roman  
(12 pt.) 
The quick, fast fox jumped over the lazy 

brown dog. 

 

 

 

Appendix Text Same as Normal The quick, fast fox jumped over the 
lazy brown dog. 

Attachments The Energy Commission 
does not require that its style 
format be used in documents 

that are attachments. 

 
not applicable 

Bullets Palatino Linotype 
11 pt. 
Space 0 pt. before bullet 
Space 4 pt. after bullet 

Indent 0.25" with hanging 

indent of an additional 0.25" 

Additional level bullets are 
each indented another 0.25" 
with a hanging indent of 

0.25". 

• Bullet item number 1 

• Bullet item number 2 

o Item number 2a 

o Item number 2b 

 Sub-bullet to 2b 

Follow last bullet with two hard 
returns to separate from next 
paragraph. 
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Style Type Definition Example 

Captions  
(Below Figures, 
Graphics, Charts, 
Drawings, 
Photographs, and 
so forth) 

Arial   
8 pt. 
Space 4 pt. before 
paragraph 
Space 8 pt. after paragraph 
Center on page (do not wrap 

text around the picture). 

Caption should be width of 

the graphic itself. 

Brief captions are preferred; 
however, some graphics 
may require a lengthier 
caption. Typically, captions 
should not introduce new 

information. 

Captions for photographs 
must include an 8 pt. credit 
line on a separate line (no 
bold, use a soft return 
between the caption and the 
credit) with the individual 
and/or company’s name that 

supplied the photo.  

Use a high resolution 
photograph 150 to 300 dots 
per inch. Don't use 72 dpi 

photos taken from websites. 

 

Figure 6: BiPV on Carport 

 
Building-integrated solar photovoltaic roofing 

materials used in a carport by Solar Utility of Culver 
City, California. 
Photo Credit: United Solar Systems Corporation 

Equations Use special charcters if 
necessary. 
Center on new line. 

Every equation presented 
must be referred to and 

explained in the text. 

If special characters are 
used to create the equation, 
make sure typefaces are 
supported and available 
across various computer 
operating systems or 
platforms. Occasionally, 
special characters may not 
be available in a standard 
typeface. It would be better 
to create the equation as a 
graphic in TIF or JPG format 
and insert it into the text as a 

graphic file. 

 

E=mc
2 

 

CO2 
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Style Type Definition Example 

Figure and Table 

Titles 
Arial 
Bold 
12 pt. 
Centered above figure or 
table 
Space 6 pt. before 
Space 12 pt. after 
Text in Title Case 
 

Colon after the figure 

number and before title.  

Figures and tables can be 
numbered in a chapter-
number format (Figure 2-1, 
Table 2-2, and so forth), or 
numbered sequentially 
throughout the entire report. 
Be consistent throughout the 
entire document. Do not mix 

formats. 

Figure 7: This Is the Title Text 

Note: Text is in title case with no period at 
the end of the title unless it is a complete 
sentence. 

Do not use Word® text boxes. 

Figures, Graphs, 
Charts, Drawings, 

Photographs 

Figures should be centered. 
Align captions with left edge 

of figure. 

Avoid the use of Word® text 
boxes wherever possible 
and insert the figures directly 

into the document. 

Every figure presented must 
be referred to in the text. 

If the figure is a graphic, 
picture or photograph, it 
should be at least 300 dots 
per inch (dpi). Do not use 

low-resolution Internet 

pictures (72 to 96 dpi). 

For an example, see Figure 1 on page 30. 

Footnotes Palatino Linotype 
10 pt. 
Spacing 0 pt before 

spacing 6 pt. after 

Note: the footnote reference 
number should be 
superscript in the text but not 

in the footnote itself. 

For an example of Footnotes, see page 56. 
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Style Type Definition Example 

Graphs Do not title a graph while it is 
being created in separate 
software, such as 
Microsoft® Excel®. The 
Figure Title should label the 
graphic. The author, 
however, should strive for 

clarity. 

• Please label all axes. 

• Use sentence case. 

• Include units. 

• Make sure point size is 
at least 12 pt. on all 

labels. 

 

Glossary Use a table with the word, 
acronym, or abbreviation in 
the left column and the 

definition in the right column.  

Do not show the gridlines of 

the table. 

Do not use multiple tabs to 
“create” a table, but use the 

table function in Word®. 

 

Heading 1 

Chapter Titles 

Arial 
18 pt. 
Bold 
Left aligned 
Space 12 pt. before 

Space 12 pt. after 

No additional return between 
the title of chapter and the 

first paragraph. 

Capitalize the word 
CHAPTER, followed by a 
colon, followed by a soft-
return, followed by the title in 

Title Case on the next line. 

Use line breaks so as to not 
orphan words all alone on 

the next line. 

CHAPTER 1: 

This Way to a Better 

Report 

 

See chapter titles throughout this 

report for other examples. 
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Style Type Definition Example 

Heading 2 

First Subheading in 

Chapter Text 

Arial 
16 pt. 
Bold 
Left aligned 
Space 6 pt. before 
Space 12 pt. after 

Should be an extra hard 
return between the ending of 
previous paragraph and the 
new subheading. 

This is Heading 2, a 

Subheading 

Heading 3 

Sub-subheading 

Arial 
14 pt. 
Italic 
Left aligned 
Space 0 pt. before 

Space 3 pt. after 

This is Heading 3, a Sub-

subheading 

Heading 4 

Sub-sub-

subheading 

Arial 
12 pt. 
No bold  
Left Aligned 
Space 3 pt. before 

Space 3 pt. after 

This is Heading 4, a Sub-sub-
subheading 

NOTE THERE ARE NO ADDITIONAL SMALLER HEADINGS! DO NOT CREATE NEW ONES! 

Page Numbers Palatino Linotype 
10 pt. 
Centered 

Bottom of page 

See bottom of this page for an example. 

References - 

Bibliography 

Normal style 

0.5" Hanging Indent 

This is an example of a reference that 
goes into a second line. The 
hanging indent approximates 
the end of the last name. 

Table Column 
Headings and 

Table Data Cells 

Arial 
Columns Heads - Bold 

Data cells - No Bold  

 

Title for following 
sections: 
Acknowledgments, 
Preface, Table of 
Contents, Abstract, 
and Executive 

Summary 

Arial 
Bold 
14 pt. 
Space 0 pt. before 

Space 12 pt. after 

Note: use a soft return to 
break the title into neat and 
easier to understand 
segments. Capitalize the 
words at the start of each 

new line. 

This is the Title Style  

For the Sections  

Mentioned on the Left 
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CHAPTER 9:  

Submitting Reports to the Energy Commission 

Most companies use the Microsoft® Office® suite of software programs for word 
processing, spreadsheets, and presentations. The Energy Commission requests that 
report files be compatible with Microsoft® products. This request, however, does not 
mean that the Energy Commission or the State of California endorse these products. 
Other word processing software programs may be used as long as the saved files are 
compatible with Microsoft® Word® XP . Please do not provide Word® 2007/2008 
format, which uses extensible markup language. The file type is .docx instead of the 
normal .doc. 

When submitting reports to the Energy Commission, please send all files relating to the 
document, including original files used to create figures, charts, or graphs. That way, the 
Energy Commission will be able to replicate the document in the future or convert it into 
future publication formats as technology changes. If you’ve questions about sending 
files to the Commission please contact your contract manager of the Commission’s 
Webmaster (916.654.4989). 

 

Word® Files 

Send copies of the cover page, credits page, and full documents as Microsoft® Word® 
.doc files. These may be combined into one file or sent as separate files. Appendices 
should be sent as .doc files as well. 

When saving the file, please make sure that the copy has all tracked changes accepted 
into the final version, unless it is undergoing further editing.  

Do not password protect or encrypt the documents or files. 

 

Document Properties 

The properties of the file must be filled out in Word®. Go to File > Properties menu 
and complete the information in the Summary portion. These include: 

• Title 

• Subject 

• Author 

• Manager 

• Company 

• Category (optional) 

• Keywords 

• Comments (optional) 

• Graphic Files and Photographs 
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File names should be descriptive of the report. So, when the Word® file is sent to the Energy 
Commission, it can be named anything as long as it is descriptive. The file name for the Word® 
and PDF files will eventually use the publication number of the report or appendix.  For example, 
the PDF file for this Style Manual is CEC-180-2008-002.PDF when the report is posted online. 

 

Graphics and Figures 

Contractors need to send a copy of all of the graphic files in the report along with the final 
document file. These files should be sent to the contract, grant, or work authorization manager 
and eventually to the Energy Commission's Webmaster on a  
CD-ROM or DVD.  

The following are things to remember regarding graphics, photographs and images of figures. 

• Embed the graphic in the report document, but also save each file separately from the 
main report.  

• Save pictures/photos in either Photoshop PSD (please include layers if used), TIF, or JPG 
formats.  

• Graphics and photographs should be saved at a higher resolution, at least 300 dots per 
inch (dpi). Do not use lower-resolution (72 or 96 dpi) graphics that are found on websites, 
as they do not reproduce well in printed documents. 

• Label graphic files names so they correspond with their figure title in the report. For 
example, if you have a photograph used as Figure 23, label the file name as figure_23.jpg. 

• Use underscores ( _ ) between words in file names instead of spaces.  

• Do not use the following characters in a file name: ! @ # $ % ^ & * ( ) : ; { } [ ] / \| 

Please note that Energy Commission publications are in the public domain because they are 
funded by public money. As such, photographs or other graphic files also are in the public 
domain. The Energy Commission reserves the right to use photographs or other graphic files in 
other publications or on the Energy Commission's website.  

 

Accessibility of Energy Commission Documents  

The California Energy Commission‘s websites must comply with American with Disabilities Act 
regulations. These include Section 508 of the Federal Rehabilitation Act of 1973, as amended (29 
U.S.C. 794d); California Government Code Section 11135 (d) (1-3); and State Administrative 
Manual (SAM) Chapters 4800-4833. 

Because of that requirement, all PDF files will need to have informational tags embedded within 
the document to alert screen readers about elements of the document. This includes having 
images tagged, paragraphs ordered for screen readers (especially if using two-column design), 
and other elements. 

Please visit the Adobe Corporation’s website on accessibility for information about making sure 
that the elements in PDF files are properly tagged and encoded at: 

http://www.adobe.com/accessibility/index.html 
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CHAPTER 10:  

Use of the California Energy Commission Seal  

The California Energy Commission seal may not be used without permission. 

The seal is used by the Energy Commission to indicate official information and/or 
official Commission publications. If it is used by other entities, it could be construed as 
an endorsement of a product or process, and the Commission and the State of California 
cannot provide such endorsements. The seal should also not appear on any website 
other than ones hosted and maintained by the Commission. 

The Energy Commission is aware of statements in marketing literature stating or 
implying Commission “approval” of products or services. The Energy Commission does 
not endorse, favor, or recommend any particular product or service. Moreover, 
California law states that: 
 

“It is unlawful for any person, firm, corporation, or association that is a 
nongovernmental entity to... solicit the purchase of or payment for a 
product or service...by means of a mailing, electronic message, or Internet 
website that contains a seal, insignia, trade or brand name, or any other 
term or symbol that reasonably could be interpreted or construed as 
implying any state or local government connection, approval, or 
endorsement….”  

 California Business and Professions Code, Section 17533.6. 

 

Occasionally, the Energy Commission’s seal is used on websites, banners, or posters for 
workshops, meetings, or conferences where the Commission is a sponsor or co-sponsor. 
Or there may be another reason for the Commission seal to appear on project-related 
items. Those uses require approval by the Energy Commission’s Media and Public 
Communications Office before a product is created. Draft versions of such documents 
will need to go through the approval/review and sign-off process. 

If you have a question about the use of the Energy Commission seal, please contact the 
Media and Public Communications Office at 916-654-4989. 
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APPENDIX A: 

Acronyms and Definitions 

Used By Energy Commission Contracts Office 

 

Acronyms 

A&E  Architectural & Engineering 
ADA  Americans with Disabilities Act 
CCC  California Civil Code 
CCM  Commission Contract Manager 
CCR  California Code of Regulations 
CEQA  California Environmental Quality Act 
CMAS  California Multiple Award Schedule 
CO  Contracts Officer 
CON  Contract Opportunity Notice 
CSCR  California State Contracts Register 
DGS  Department of General Services 
DOF  Department of Finance 
DVBE  Disabled Veteran Business Enterprise 
GC  California Government Code 
IA   Interagency Agreement 
IFB  Invitation for Bids 
IT   Information Technology 
MM  Management Memo 
MOU  Memorandum of Understanding 
MSA  Master Services Agreement 
NCB  Non-Competitive Bid 
OLS  Office of Legal Services, DGS 
OSDC  Office of Small/DVBE Certification 
PCC  Public Contract Code 
PD  Procurement Division 
PON  Program Opportunity Notice 
RFP  Request for Proposals 
RFQ  Request for Qualifications 
RFQ  Request for Quotations 
SAM  State Administrative Manual 
SB   Small Business 
SBDVBE  Small Business Disabled Veteran Business Enterprise Program 
SCM  State Contracting Manual 
SOW  Scope of Work 
2CCR  Title 2, California Code of Regulations 
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Definitions 

ADVANCE PAYMENT - Any payment made to a contractor before work has been 
performed or goods have been delivered. Advance payments are permitted only if 
authorized by statute. (For example, interagency agreements may provide for advance 
payments under GC, Section 11257). 

AGREEMENT - A contract. 

AMENDMENT - A formal modification or change of a material term, such as the term, 
cost, or scope of work, in one or more provisions of an existing contract. 

ASSIGNMENT - Transfer of contractual rights from one person to another. 

BID - A potential contractor’s reply to a solicitation for purchase of goods or services 
which represents what the contractor would charge to provide those goods or services. 

BIDDER - An individual, sole proprietorship, firm, partnership, corporation, or any 
other business venture that responds to an Invitation for Bids or Request for Proposals 
by submitting a bid.  A potential contractor. 

BOARD RESOLUTION - A formal decision by the governing body of a public agency, 
often required to authorize the purchase of goods or services, or to authorize a contract 
for services. 

BREACH OF CONTRACT - Failure, without legal reason, to comply with the terms of a 
contract. 

CALIFORNIA STATE CONTRACTS REGISTER - The state publication, now electronic, 
containing advertisements for contract solicitations and a list of contracts for which 
exemptions from bidding have been approved. 

CERTIFIED SMALL OR MICRO-BUSINESS - A business that has been certified by the 
Small Business and DVBE Certification Program, Department of General Services, as a 
small or micro-business defined in GC, Section 14837 and 2CCR, Section 1896. The 
OSDC issues the business a letter of certification that allows the business to claim the 
small business preference when submitting bids or proposals and to obtain statutory 
penalties for late payments on contracts. (SCM 8). 

CIRCUMVENTION - The act of avoiding the effect or intent, going around, defeating by 
ingenuity or strategy, or nullifying the purpose, (as in circumvention of 
competitiveness). 

CMAS CONTRACT - A contract awarded using the California Multiple Award 
Schedule.  

COMMERCIALLY USEFUL FUNCTION - Any time a subcontract is awarded to a 
certified Small Business or Micro Business for Small Business Preference, or Disabled 
Veteran Business Enterprise (DVBE) for goal participation, that subcontractor(s) must be 
providing goods or services that contribute to the fulfillment of the contract 
requirements by performing a commercially useful function.   A certified small or micro 
business or DVBE is deemed to perform a commercially useful function if it does all of 
the following: 

1. Is responsible for the execution of a distinct element of the work  of the contract. 

2. Carries out its obligation by actually performing, managing, or  supervising the 
work involved. 
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3. Performs work that is normal for its business services and functions. 

4. Is not further subcontracting a portion of the work that is greater than that 
expected to be subcontracted by normal  industry practices. 

A contractor, subcontractor, or supplier will not be considered to perform a 
commercially useful function if the contractor's, subcontractor's, or supplier's role is 
limited to that of an extra participant in a transaction, contract, or project through which 
funds are passed in order to obtain the appearance of small, micro business or DVBE 
participation. 

COMMODITIES - Goods, including such tangible items as movable or personal 
property, as opposed to services. 

COMPETITIVE BIDDING - A purchasing process in which the opportunity to make 
offers to supply goods or services is not limited to any one bidder. All bidders are 
evaluated on the same fixed criteria. 

CONSIDERATION - Something of value that induces a person to enter into a contract. 
The consideration may include some right, interest, profit, or benefit obtained by one 
party, or some forbearance, detriment, loss, or responsibility assumed by the other 
party. 

CONSULTING SERVICES CONTRACT - A contract for services of an advisory nature, 
which provides a recommended course of action or personal expertise. The definition 
does not include A&E contracts (PCC 10335.5; SCM 3). 

CONTRACT - A legally binding agreement between the state and another entity, public 
or private, for the provision of goods or services. 

CONTRACT MANAGER - A staff person designated by the Commission to manage 
performance under a contract. No staff member of the Commission may act as a 
Contract Manager until they have become certified by taking the contract management 
training given by the Contracts Office. 

CONTRACTOR IDENTIFICATION NUMBER - The number assigned to the contractor 
for tax purposes. This may be the contractor’s social security number, or the federal 
identification number. Contract Managers are responsible for obtaining this number 
from the contractor and providing it on the form CEC-26 in a contract request package. 

COOPERATIVE AGREEMENTS - A special agreement with the federal government in 
which there is a general public benefit, as opposed to a specific benefit accruing only to 
the contracting federal agency. 

CORPORATION - A fictional entity, created by or under the authority of the laws of a 
state, which has the legal authority to engage in certain activities. 

DEFAULT/BREACH - Failure to perform an obligation in a contract. 

DIRECT COST - Any cost that can be specifically identified as generated by and in 
accordance with the provisions or activity requirements of the contract. 

DISABLED VETERAN BUSINESS ENTERPRISE - A business that meets the criteria set 
up by the Military and Veterans Code, Section 999(g).  

ENCUMBRANCE - A commitment of funds guaranteeing a source of payment for a 
specific transaction. 
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ENCUMBRANCE DATE - Date that funds have to be allocated to a contract, grant, or 
purchase order by. 

Generally, there is one year to encumber the funds from the beginning of the fiscal year. 

ENTERPRISE ZONE ACT - (GC, Sections 7080 et seq.) Provides preferences for state 
contracting opportunities in designated enterprise zones. 

EVALUATION COMMITTEE - A committee or panel of three or more  that convenes to 
evaluate the qualifications of bidders who respond to  RFPs or RFQs. 

EXECUTION OF A CONTRACT - The act of signing a contract, which provides a legal 
basis for required performance by parties to the contract. 

EXECUTIVE ORDER - A directive issued by the Governor that establishes binding 
policy for government agencies covered therein. 

EXEMPTION - A formal waiver by DGS, of DGS responsibilities required by statute, 
regulation, or policy, or a delegation of such responsibilities by DGS to a state agency. 
Some common exemptions awarded by DGS involve contract approval, advertising, and 
competitive bidding requirements. 

GENERAL PROVISIONS - Terms and conditions that apply to all contracts for services 
and are included in any final document. 

GOOD FAITH EFFORT - A sincere effort to meet the legal steps made by a bidder or 
potential contractor to meet DVBE goals as defined in PCC, Section 10115.2(b) and the 
implementing regulations. 

HEARING - A formal proceeding, customarily public, in which evidence is presented 
and issues of fact or law are adjudicated. 

INCOME/REVENUE CONTRACT - A contract in which the Commission is receiving 
money in exchange for services provided. 

INDEMNIFICATION - Contractual provision in which one party will reimburse the 
other party for settlements or judgments on claims arising from the contract. 

INDIRECT COST RATES/OVERHEAD - An amount or pro rata share of existing 
salaries and benefits, rent, equipment, materials, and utilities attributable to a function 
or activity but not necessarily generated by the function or activity. 

IN-KIND SERVICES - Services performed in exchange for other services in lieu of 
money. 

INTERAGENCY AGREEMENT - An agreement between two or more state agencies 
(GC, Sections 11256-11263; SCM 3.03). 

INVITATION FOR BIDS (IFB) - A type of solicitation document, used in a formal 
competitive bidding process, which contains a precise statement and complete 
specification of what the Commission is attempting to purchase.   Qualifying bidders 
compete solely on the basis of cost. 

JOINT POWERS AGENCY - An agency formed by agreement of two or more public 
agencies.   Under this agreement, the joint powers authority may exercise any power 
common to the contracting parties (GC,  Section 6502). 

LEGAL SERVICES CONTRACT - Any contract for services rendered by an 
attorney.   Legal services contracts are exempt from advertising or solicitation. 
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LIQUIDATION DATE - Date that all funds must be paid out, or expended. Generally, 
there are two years to liquidate the funds after encumbrance. 

LOCAL AGENCY MILITARY RECOVERY AREA ACT (LAMBRA) - Provides 
preference for state contracting opportunities in designated local agency military base 
areas. 

MASTER SERVICES AGREEMENT (MSA) - An agreement entered into by the 
Department of General Services or another state agency for use by other state agencies 
that wish to use the same services. It may also be an agreement by a state agency for use 
by divisions of that agency (SCM 3.4). 

MEMORANDUM OF UNDERSTANDING (MOU) - A contract between two entities, 
usually a signed agreement with no cost involved. 

MICRO-BUSINESS - See Certified Small Business. 

NON-COMPETITIVE BID (NCB) - This term replaces sole source.   A situation in which 
only a single business enterprise is afforded the opportunity to offer the State a price for 
the specified goods or services. 

PRE-BID CONFERENCE - A meeting with potential bidders before the proposal 
submission date of a solicitation. 

PRIMARY RFP - The two-envelope method for evaluating proposals in which 
qualifications and cost proposals are submitted in two separate sealed 
envelopes.   Qualifications are first evaluated according to criteria set in the RFP.   For 
Bidders who meet the minimum qualifications standards, the scoring team then 
evaluates the cost proposals.   The award is made to the lowest bidder meeting the 
minimum qualifications, if that bidder is deemed to be commercially useful. 

PROGRESS PAYMENTS - Partial payments related to steps or phases toward the 
completion of the required services under a contract. 

PROMPT PAYMENT ACT - Statutory provisions that set interest penalties on late 
payments for state contracts (GC, Sections 926.15, 926.17). 

PROPRIETARY SOFTWARE - Software that is owned and copyrighted by the contractor 
who in turn sells licenses for the use of this product. 

PROTEST - A formal challenge by a bidder to the intended award of a contract via 
solicitation. 

PUBLIC ENTITY - A county, city, district, local public body, state board, state 
commission, federal agency, or joint powers authority. 

RESOLUTION - A formal decision by the governing body of a public agency, often 
required to authorize the purchase of goods or services. 

RESPONSIBLE BIDDER - A bidder who is fully capable of performing the contract. 
When there is documented evidence that a bidder is not financially qualified or is 
otherwise unable to perform the required services, the bidder may be deemed not 
responsible and the bid may be rejected by the awarding agency. The bidder may then 
protest the intended award of the contract and is entitled to a hearing. 

RESPONSIVE BIDDER - A bidder whose bid meets the specifications and other 
requirements contained in an RFP or RFQ. 
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SECONDARY RFP - The method for evaluating proposals obtained through the RFP in 
which an evaluation panel assesses each proposal according to a set of criteria, of which 
one must be the cost.   Each criterion is assigned a weight, with substantial weight going 
to cost.   The awrd is made to the bidder whose proposal is given the highest score. 

TARGET AREA CONTRACT PREFERENCE ACT (TACPA) - TACPA (GC, Section 4530 
et seq.) provides preferences for contracting opportunities in distressed areas. 
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